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The CDE Companion Guide is divided into two parts. Part 1
provides an introduction to the Common Desktop Environment
(CDE) for those users who are not familiar with desktop
interfaces. Part 2 provides information on migrating from
DECwindows Motif to CDE.

Note

In this manual all references to DECwindows refer to
the DECwindows Motif software.

Audience
This manual is divided into two parts and has distinct and separate
audiences as follows:

• The user who is unfamiliar with desktop environments

• The user who wants to migrate from DECwindows Motif to
the CDE environment

For the user who is new to desktop environments, this book
provides quick start information on logging into the system,
navigating in the new environment, and managing the desktop and
applications. Also included in this manual is information on using
Digital applications.

For the person migrating from DECwindows Motif to CDE, this
book serves as an introduction to the new environment. It
provides information on how to use CDE to complete tasks
previously done by using DECwindows Motif.

Organization
This book is organized in two parts that consists of 10 chapters.
Part 1 is a primer that introduces CDE to those users who are not



familiar with a desktop environment. Part 2 provides information
on migrating from DECwindows Motif to CDE.

Part l Introduces the Common Desktop Environment
(CDE) and provides information on getting started in
this environment.

Chapter 1 Describes the main components of CDE and
describes how to access the documentation set,
online help, and reference pages.

Chapter 2 Provides information on navigating in the CDE
desktop using the mouse and keyboard, and
describes how to start and end a desktop session.

Chapter 3 Provides a tour of the Front Panel and explains how
to access applications, use subpanels, and use
workspaces.

Chapter 4 Describes how to use the desktop to manipulate
files, access applications, and customize the
environment.

Chapter 5 Provides an overview of the Digital UNIX desktop
and system management utilities which have been
integrated into CDE.

Part 2 Discusses migrating from the DECwindows Motif
environment to CDE.

Chapter 6 Provides an overview of the common components
and differences between DECwindows Motif and
CDE.

Chapter 7 Describes differences between DECwindows Motif
and CDE when starting and ending a session and
accessing applications.

Chapter 8 Describes the CDE methods used to customize your
desktop environment instead of using DECwindows
Motif.

Chapter 9 Discusses internationalization migration issues in
CDE for those who used these features in
DECwindows Motif.

Chapter 10 Describes how to convert DECwindows mail folders
and calendar databases to a format that is understood
by the CDE mail and calendar applications.

Appendix A Describes differences between MH/DXmail and the
CDE mail application.
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Related Documents
The printed version of the Digital UNIX documentation set is
color coded to help specific audiences quickly find the books that
meet their needs. (You can order the printed documentation from
Digital.) This color coding is reinforced with the use of an icon on
the spines of books. The following list describes this convention:
22222222222222222222222222222222222222222222222222
Audience Icon Color Code22222222222222222222222222222222222222222222222222
General users G Blue

System and network administrators S Red

Programmers P Purple

Device driver writers D Orange

Reference page users R Green22222222222222222222222222222222222222222222222222

Some books in the documentation set help meet the needs of
several audiences. For example, the information in some system
books is also used by programmers. Keep this in mind when
searching for information on specific topics.

The Documentation Overview, Glossary, and Master Index
provides information on all of the books in the Digital UNIX
documentation set.

Reader’s Comments
Digital welcomes any comments and suggestions you have on this
and other Digital UNIX manuals.

You can send your comments in the following ways:

• Fax: 603-881-0120 Attn: UEG Publications, ZK03-3/Y32

• Internet electronic mail:
readers_comment@zk3.dec.com

A Reader’s Comment form is located on line in the following
location:
/usr/doc/readers_comment.txt
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• Mail:

Digital Equipment Corporation
UEG Publications Manager
ZK03-3/Y32
110 Spit Brook Road
Nashua, NH 03062-9987

A Reader’s Comment form is located in the back of each
printed manual. The form is postage paid if you mail it in the
United States.

Please include the following information along with your
comments:

• The full title of the book and the order number. (The order
number is printed on the title page of this book and on its back
cover.)

• The section numbers and page numbers of the information on
which you are commenting.

• The version of Digital UNIX that you are using.

• If known, the type of processor that is running the Digital
UNIX software.

The Digital UNIX Publications group cannot respond to system
problems or technical support inquiries. Please address technical
questions to your local system vendor or to the appropriate Digital
technical support office. Information provided with the software
media explains how to send problem reports to Digital.

Conventions
The following conventions are used in this manual:

%
$

A percent sign represents the C shell system prompt. A
dollar sign represents the system prompt for the Bourne and
Korn shells.

# A number sign represents the superuser prompt.

% cat Boldface type in interactive examples indicates typed user
input.

file Italic (slanted) type indicates variable values, placeholders,
and function argument names.
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[ | ]
{ | }

In syntax definitions, brackets indicate items that are optional
and braces indicate items that are required. Vertical bars
separating items inside brackets or braces indicate that you
choose one item from among those listed.

cat(1) A cross-reference to a reference page includes the appropriate
section number in parentheses. For example, cat(1)
indicates that you can find information on the cat command
in Section 1 of the reference pages.

Ctrl/x This symbol indicates that you hold down the first named key
while pressing the key or mouse button that follows the slash.
In examples, this key combination is enclosed in a box (for
example, 1Ctrl/C 1222222777777 ).
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Part 1 Introducing the Common Desktop
Environment3333333333333333333333





1Introducing the Common Desktop
Environment3333333333333333333333

The Common Desktop Environment (CDE) provides an easy
method of interacting with the Digital UNIX operating system.
It is a jointly developed graphical user interface based on industry
standards which include the X Consortium’s X Window System
and the Open Software Foundation’s Motif user interface. By
using the CDE interface, you can use the mouse or keyboard to
navigate and interact with applications.

CDE presents a visual desktop that you can customize. From the
desktop, it is easy to access and manage applications. The desktop
itself offers a Front Panel, a graphical display at the bottom of the
screen area that provides access to applications, printers, and
frequently used objects including online help. It also offers you
the option of working in different workspaces. A workspace is the
screen itself, which includes the Front Panel. By using a control
on the Front Panel, you can switch between different workspaces.

This chapter provides a quick overview of the following:

• Logging in and accessing applications

• Managing the desktop and applications

• Accessing online help

• Locating other sources of information

1.1 Logging in and Accessing Applications
The login screen, displayed by the Login Manager, provides you
access to the desktop. Not only can you enter your login name
and password, it also provides an Options menu where you can
select the type of session you want to begin, and the language to
use in your session.

You have the option of starting one of the following sessions:

• The regular desktop starts the CDE Session Manager after the
Login Manager has verified your login and password. This is
the default desktop for Digital UNIX. Upon exiting a session,
the Session Manager remembers the state of your last session
and restores it when you log in next.



• A dxsession session starts the DECwindows Session Manager.
This was the default Session Manager on previous Digital
UNIX systems. For information on using a DECwindows
session, see the DECwindows User’s Guide.

• A failsafe session starts a single terminal window and the
Window Manager. This is useful when you need access to a
single terminal window if there are problems preventing a
successful login to a session.

• A command-line session suspends the desktop and provides a
way for you to work in the base operating system environment,
an environment without windows. Because the Login Manager
is not active and the X server is not running, a login screen is
not displayed.

The default language is set by your system administrator; however,
you can also access other languages that are installed on your
system. Choosing a language from the Options menu sets the
environment variable LANG for the duration of your session. The
default language is restored when you end your session. See
Chapter 9 for information on using internationalization features.

1.1.1 Front Panel
The Front Panel window is located at the bottom of the desktop.
It provides controls (represented by icons) that start applications,
and subpanels that you can use in your daily work. The Front
Panel also provides a workspace switch, which you can use to
move between different work areas. Chapter 3 describes the
default applications available from the Front Panel and discusses
how to use subpanels and workspaces.

You can customize the Front Panel by adding and removing
controls from the Front Panel and subpanels, adding and removing
workspaces, and renaming workspaces. If you are familiar with
using desktops, you can also create a Front Panel customized
configuration file. See the Common Desktop Environment: User’s
Guide for details on customizing the Front Panel. For information
on creating configuration files, see the Common Desktop
Environment: Advanced User’s and System Administrator’s Guide.

1.1.2 Workspaces
A workspace is the screen display area. Using CDE, you can
move between different workspaces by using the workspace
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switch, which is numbered one through four on the Front Panel.
By switching from one workspace to the next, you can set up
multiple work areas. For example, one workspace can be used for
managing mail, another for project management, and so on. The
Front Panel is available in each workspace.

By default, there are four workspaces, but you can add, delete, or
rename workspaces. See Chapter 3 for more information.

1.2 Managing the Desktop and Applications
The desktop has a File Manager, Style Manager, and Application
Manager. Each of these provides you with a specific control in the
desktop environment. The following list introduces these controls:

• File Manager

The File Manager provides a view of desktop objects, which
includes files, directories, and applications. All objects are
represented by an icon. Using the drag and drop features of
the File Manager, you can easily manipulate files and
directories, and interact with other applications.

• Style Manager

You can use the Style Manager to customize the appearance of
your desktop. Using the Style Manager, you can control the
workspace colors and palettes, fonts, backdrop patterns,
keyboard click and character repeat, mouse button settings,
audio, screen blank and screen lock, window focus, icon
placement, and how your session begins and ends.

• Application Manager

The Application Manager is a special directory (folder) for
applications and other tools available on your system. Most of
the tools available are installed by the System Administrator or
built into the desktop, but you can also customize the
Application Manager by adding other applications.

See Chapter 4 for additional information on these controls.

1.3 Obtaining More Information
The CDE documentation set is available on line and in hardcopy.
You can also obtain information about CDE from the CDE Video
Tour, online help volumes, and reference pages.
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1.3.1 CDE Video Tour
The CDE Video Tour provides an introduction to the CDE
interface and its components. Before using the CDE Video Tour
on your system, you must install the subsets for Multi Media
Services. The Installation Guide provides instructions on installing
subsets.

To start the CDE Video Tour, use the following steps:

1. Start the Application Manager.

2. Double click on Information.

3. Double click on CDE Video Tour.

For more information, see the online help volume for the CDE
Video Tour.

1.3.2 CDE Documentation Set
The CDE documentation set has three audiences: general user,
programmer, and ToolTalk programmer. Table 1-1 through Table
1-3 groups these manuals by audience and describes each set.

Table 1-1:   CDE User Documentation
2222222222222222222222222222222222222222222222222222222222222
Manual Description2222222222222222222222222222222222222222222222222222222222222
Common Desktop Environment:
Advanced User’s and System
Administrator’s Guide

Describes how to perform
advanced customizations of the
CDE environment.

Common Desktop Environment:
Desktop KornShell User’s Guide

Provides the information you need
to create Motif applications with
KornShell (kshell) scripts.

Common Desktop Environment:
Product Glossary

Provides a comprehensive list of
terms used in CDE, and serves as a
source and reference base for all
users of the desktop.

Common Desktop Environment:
User’s Guide

Outlines basic features of CDE and
explains how to use the desktop
and desktop applications such as
the File Manager and Application
Manager.2222222222222222222222222222222222222222222222222222222222222
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Table 1-2:   CDE Programmer’s Documentation
2222222222222222222222222222222222222222222222222222222222222
Manual Description2222222222222222222222222222222222222222222222222222222222222
Common Desktop Environment:
Application Builder User’s Guide

Describes the Application Builder,
which is an interactive tool for
developing CDE applications.

Common Desktop Environment:
Help System Author’s and
Programmer’s Guide

Describes how to develop online
help for application software and
integrate help into an application.

Common Desktop Environment:
Internationalization Programmer’s
Guide

Discusses how to internationalize
an application so that it can be
localized to support various
languages and cultural conventions
in a consistent user interface.

Common Desktop Environment:
Programmer’s Guide

Discusses the elements of CDE
and describes how to use them.

Common Desktop Environment:
Programmer’s Overview

Provides overview information on
building new CDE applications,
integrating applications into the
desktop, and design issues.

Common Desktop Environment:
Style Guide and Certification
Checklist

Provides application design style
guidelines and lists the
requirements for CDE-level
certification.2222222222222222222222222222222222222222222222222222222222222

Table 1-3:   CDE ToolTalk Documentation
2222222222222222222222222222222222222222222222222222222222222
Manual Description2222222222222222222222222222222222222222222222222222222222222
Common Desktop Environment:
ToolTalk Messaging Overview

Describes the ToolTalk
components, commands, and error
messages.

Common Desktop Environment:
ToolTalk Reference Manual

Describes the Application Interface
(API) components, commands, and
error messages of the ToolTalk
service.

Common Desktop Environment:
ToolTalk User’s Guide

Describes the ToolTalk service and
how to modify your application to
send and receive ToolTalk
messages.2222222222222222222222222222222222222222222222222222222222222
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1.3.2.1 Using the Netscape Viewer

To view the CDE documentation on line, use the Netscape Viewer
as follows:

1. Mount the Digital UNIX documentation CD-ROM under
/usr/share/doclib/online.

You must have root privileges to mount the documentation
CD-ROM.

2. Start the Netscape Navigator by using one of the following
methods:

From the CDE desktop:

a. Click on the Application Manager.

b. Double click on Desktop_Apps.

c. Double click on the Netscape icon.

From a terminal emulator window, enter:
$ /usr/bin/X11/netscape &

3. Load the Digital UNIX home page from the Navigator window
by entering:
file:/usr/doc/netscape/Digital_UNIX.html

4. Select the Digital UNIX Documentation bookshelf from the
list of options.

5. Click on the Bookmarks menu, then click on the Add
Bookmark option to save this bookshelf for future use.

1.3.2.2 Obtaining Hardcopy Documentation

To obtain the CDE documentation set in hardcopy, use the
ordering instructions at the back of this manual. You have the
option of ordering manuals electronically.

1.3.3 Online Help
Online help provides detailed information on the CDE interface
and applications. From the Front Panel, click on the Help
Manager to access a collection of help volumes. To access the
help from within an application, click on the Help menu.
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1.3.3.1 Using the Help Manager

The Help Manager is located on the Front Panel. It is a special
help volume that lists all the online help registered on your
system. To browse through registered online help, click on the
Help Manager icon. To navigate within the Help Manager online
help volume, click on any underlined topic and use the help menus
and buttons.

The Help Manager icon has an arrow above it, which indicates that
a subpanel is available. To view specific help topics about the
desktop and Front Panel, click on the arrow. The subpanel also
includes On Item help for the Front Panel. On Item help is
interactive. Clicking on this option turns the pointer into a
question mark (?). By positioning the pointer over an item in the
Front Panel, then releasing, you receive help on that item.

1.3.3.2 Using an Application’s Help Menu

To access help from within a help volume, click on the Help
menu. A typical online help volume is divided into several
sections. Table 1-4 describes the contents of an online help
volume.

Table 1-4:   Contents of an Online Help Volume
2222222222222222222222222222222222222222222222222222222
Menu Item Description2222222222222222222222222222222222222222222222222222222
Overview Introduces the use of the application.

Tasks Provides instructions on how to complete
operations you can perform using the
application.

Reference Displays summaries of an applications’
components such as windows, dialog boxes,
menus, and application resources.

On Item Provides reference information on the
specific item you selected.

Using Help Describes how to use the help windows.

About Application Displays the version and copyright
information for the application.2222222222222222222222222222222222222222222222222222222
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1.3.4 Reference Pages
Reference pages, often referred to as manpages, provide a synopsis
and description of each command or application on the system. If
the reference page subset is installed on your system, you can
access reference pages using the Man Page Viewer or you can type
the man command in a terminal emulator window.

1.3.4.1 Using the Man Page Viewer

To use the Man Page Viewer to view reference pages:

1. Click on the Application Manager.

2. Double click on Desktop_Apps.

3. View a reference page using one of the following methods:

– Double click on the Man Page Viewer icon and enter the
name of the reference page you want to view.

– Drag and drop an icon or object from the desktop onto the
Man Page Viewer.

See Section 1.3.4.3 for information on obtaining command and
applications names by using a keyword.

1.3.4.2 Using the man Command

To view a reference page in a terminal emulator window, enter the
man command followed by the name of the command or
application you want to view. For example, to view the reference
page for the CDE Session Manager, enter the following:
$ man dtsession

See Section 1.3.4.3 for information on obtaining command and
applications names using a keyword.

1.3.4.3 Locating Command and Application Names

If you are unsure of a command or application name, use the
apropos command with a keyword to locate the reference page
you are seeking. For example, to find the dtsession reference
page, enter the following:
$ apropos session

Any reference page that contains the word session in the name line
or title of the reference page is displayed on your system including
the dtsession reference page.

1–8 Introducing the Common Desktop Environment



2Getting Started with CDE3333333333333333333333
The Common Desktop Environment (CDE) presents a visual
desktop that you can use to interact with the Digital UNIX
operating system. This chapter introduces the basic skills you
need to perform tasks in the desktop environment. It then
describes how to start, pause, and exit from a desktop session.

2.1 Navigating in the CDE Desktop
To navigate within the CDE desktop, you can use the mouse or
keyboard. Both provide you with a method of accessing and
interacting with the desktop and applications. The following
sections describe the mouse and keyboard controls.

2.1.1 Using the Mouse
The mouse is a three button control connected to your workstation.
Moving the mouse on a smooth surface directs the movement of
the pointer that appears on your desktop. The pointer is shaped
like an arrow by default, but it changes shape depending on the
action that is being performed. When you perform tasks using the
mouse pointer, you specify what to act on by positioning the
pointer over that object.

The three mouse buttons determine the type of action that is
performed. By default, mouse button 1 is the left button, mouse
button 2 is the center button, and mouse button 3 is the right
button. By pressing and releasing the mouse buttons, actions
occur.

Mouse button 1 is used typically to do the following:

• Start applications

• Select and manage objects in the desktop or in applications

• Cut and paste text

• Move objects on the desktop

• Change the size of objects on the desktop



Mouse button 2 is often used in copy and paste operations or to
move objects. Mouse button 3 is used to display and manipulate
pop-up menus (see Section 2.2.2.2 for information on menus).

When you use the mouse to interact with the desktop and
applications, you are often instructed to perform click, double-
click, or drag and drop operations.

• To perform a click operation, point to the object, then press
and release the specified mouse button.

• To perform a double-click operation, point to the object, and
click the specified mouse button twice in quick succession.

• To perform a drag and drop operation, position the pointer on
the object, then press and hold the specified mouse button
while moving the pointer (and object) to a new position.
Release the mouse button to drop the object in the new
location.

See the Common Desktop Environment: User’s Guide for detailed
information on using the mouse.

2.1.2 Using the Keyboard
You can use the keyboard instead of the mouse to interact with the
desktop. To use the keyboard as a navigator, you combine keys to
complete actions. The following list highlights actions you can
perform with the keyboard:

• Start applications

• Select objects on the desktop

• Size objects on the desktop

• Move objects on the desktop

• Manipulate the scroll bars in applications

• Display and select objects

Most of the tasks documented in this chapter can be performed
using the mouse or keyboard, however only examples of using the
mouse are provided. For instructions on using the keyboard to
complete tasks, see the Common Desktop Environment: User’s
Guide.

2.2 Using Windows
When you start most applications, the application is displayed on
your desktop in a framed rectangular window. An application may
have more than one window.
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The window itself is your work area or a place to interact with the
application. The window frame has controls that you can use to
manage the window. Window controls consist of a title bar, resize
borders, buttons, and scroll bars. Some windows also have a
Menu Bar.

A Menu Bar offers a choice of menus and menu items that you
can use to further manipulate a window or application. Some of
the menu items open dialog boxes. A dialog box is similar to a
window and provides you with a means of interacting with the
system or an application.

The following sections discuss window controls and provide
information on managing windows, menus, and dialog boxes. To
complete the actions, you must be familiar with mouse or
keyboard techniques. The remaining sections in this chapter
highlight the use of the mouse only.

2.2.1 Managing Window Controls
Usually, a window frame consists of a title bar, resize borders,
buttons, and scroll bars. Table 2-1 highlights these features.

Table 2-1:   Window Controls
22222222222222222222222222222222222222222222222222222222222222
Window Control Description22222222222222222222222222222222222222222222222222222222222222
Title bar Displays the name of the application and contains a

Window menu button, Minimize button, and
Maximize button.

Click the Window menu button to display the
window menu, then click on menu items to change
the characteristics of the window. Double clicking
on the Window menu button closes (or exits) the
application.

Click the Minimize button to turn a window into an
icon. An icon is a graphical representation of an
object. To restore an icon, double-click on the icon.

Click the Maximize button to display the window in
its largest size. To restore the window to its original
size, click on the Maximize button again.

Resize border and
corners

Makes a window larger or smaller. Drag either the
border or corner to size the window.
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Table 2-1:   (continued)
22222222222222222222222222222222222222222222222222222222222222
Window Control Description22222222222222222222222222222222222222222222222222222222222222
Scroll bars Enable you to view information such as text or

graphics that is not displayed in the current work
area. You optionally can have horizontal or vertical
scroll bars, or both. Slide the scroll bars by
positioning the pointer over the scroll arrows or bar
and moving the mouse.22222222222222222222222222222222222222222222222222222222222222

2.2.2 Managing Multiple Windows, Menus, and Dialog Boxes
When you run an application, a window is opened. Most often,
you run several applications concurrently, thus you have more than
one window opened on your desktop at the same time. Likewise,
most application windows have menu bars, and certain
applications open two windows or provide dialog boxes.

The following sections provide an overview of managing
windows, menus, and dialog boxes.

2.2.2.1 Handling Multiple Windows

Using the window controls is one of the available methods for
managing windows. You can also manage multiple windows
using the mouse and keyboard. The following lists some actions
you can perform using the mouse:

• Make a window active by pointing to any part of a window,
then click mouse button 1 or 2. The title bar of the window
changes to indicate that this window is ready for input.

• Move a window or window icon by pointing to the window’s
title bar or icon, then drag the window or icon to a new
location.

• Move a partially hidden window or window icon to the
foreground of your desktop by clicking on any portion of the
window or icon.

• Copy text from a window and paste it in another window as
follows:

1. Move the pointer to the start of the text you want to copy.

2. Drag the pointer to the end of the text and release the
mouse button which highlights the text you want to move.
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3. Point to the location where you want to insert text.

4. Click mouse button 2 or 3 to paste the text.

If you decide you do not want to paste the selected text,
keep the pointer in the window that has the selected text,
point to an empty space, then release the mouse button.

See the Common Desktop Environment: User’s Guide for more
information.

2.2.2.2 Handling Menus

Menus present you with a list of items that you can use to interact
with windows, applications, and the desktop. Often, a menu item
specifies an action that is to be performed on an object you select.
Sometimes a menu item is dimmed. This indicates that the item is
currently unavailable, and is available only under certain
conditions.

Table 2-2 lists the three types of menus.

Table 2-2:   Menu Types
222222222222222222222222222222222222222222222222222222222
Menu Type Description222222222222222222222222222222222222222222222222222222222
Pulldown Located on an application’s menu bar, just below the

title bar. A menu bar may contain one or more
pulldown menus.

To pull down a menu, click on the menu’s name.

To select a menu item, click on the menu’s name,
then click on the menu item.

Pop-up Present in some applications, desktop objects, and
on the workspace itself. In applications, these
menus often duplicate the items in the pulldown
menu. Providing them in a pop-up menu offers
further flexibility when you are working in
applications.

To pop up a menu, click mouse button 3 in an
application window, on a desktop object, or on the
desktop.
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Table 2-2:   (continued)
222222222222222222222222222222222222222222222222222222222
Menu Type Description222222222222222222222222222222222222222222222222222222222
Option Appear in dialog boxes. Option menus appear as

buttons, and while they can contain more than one
item, only the active option is displayed.

To view all menu items, click on the Option menu
(button).

To select a menu item from the Option menu, click
on the Option menu (button), then click on the item.222222222222222222222222222222222222222222222222222222222

A menu item followed by an arrow opens a submenu when
selected. Select items in submenus by clicking on the menu item.
A menu item that is followed by three dots (...) opens a dialog box
when selected.

See the Common Desktop Environment: User’s Guide for more
information.

2.2.2.3 Handling Dialog Boxes

Some applications have dialog boxes. Dialog boxes typically
require that you input additional information before an action is
performed. There are several types of controls that appear in
dialog boxes. While some dialog boxes may use several controls,
others may use only one.

Table 2-3 list possible controls for dialog boxes.

Table 2-3:   Dialog Box Controls
222222222222222222222222222222222222222222222222222222
Control Purpose222222222222222222222222222222222222222222222222222222
Text entry box Provides fields for entering requested

information. An insertion cursor shows
where to enter text. If the cursor is
blinking in a field, the text entry box is
ready for input. If it is not blinking, click
on the text entry box to activate the box.
You can delete characters in these fields by
using the Delete Key.

Radio button Provides a list of available options. Click
on a Radio button to view options.
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Table 2-3:   (continued)
222222222222222222222222222222222222222222222222222222
Control Purpose222222222222222222222222222222222222222222222222222222
Check button Controls on and off settings. Click on a

Check button to turn settings on or off.

Sliders and scales Selects numeric values. Drag the slider or
scale to select a value.

List box Provides a menu of options. If a list box
has numerous options, a scroll bar appears.
You can select an option by clicking on it.

Push button Used to respond to queries, to indicate how
an application is to handle information you
have input, or to offer a set of options. To
perform a push button operation, click on a
push button.222222222222222222222222222222222222222222222222222222

For more information on dialog boxes, refer to the Common
Desktop Environment: User’s Guide.

2.3 Starting a Session
The Login Manager displays a login screen. The login screen has
fields where you must enter your user name and password. Push
buttons at the bottom of the screen are used to manage your login
session:
2222222222222222222222222222222222222222222222222222222
Button Description2222222222222222222222222222222222222222222222222222222
Ok Indicates that the information you entered is correct.

Start Over Resets the login screen if you enter incorrect
information or lose your place.

Options Displays the Options menu. The Options menu is
used to select the type of session you want to start
and to specify a language.

Help Provides details on using the login screen.2222222222222222222222222222222222222222222222222222222

To start a session:

1. Type your user name and press the Return key or click OK.

2. Select the options you want, if any, from the Options menu.

3. Type your password and press the Return key or click OK.
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2.3.1 Selecting a Language
The default language for your system is set by your system
administrator; however, you can access other languages that are
installed on your system by using the Options menu as follows:

1. Click on the Options menu.

2. Click on the Language menu item and select a language group.

3. Select a language.

Choosing a language from the Options menu sets the environment
variable LANG. The default language is restored at the end of the
session.

2.3.2 Selecting a Session
Selecting a session determines how your work environment is set
up during your login session. You have the option of starting a
Regular Desktop Session, dxsession Session, Failsafe Session, or
Command Line Session.

Select a session from the Options menu as follows:

1. Click on the Options menu.

2. Click on the Session menu item.

3. Select the type of session you want to start.

A Regular Desktop Session starts the CDE Session Manager.
When you start a CDE desktop session, a console window and a
Front Panel are displayed. The console displays all system
messages received during a session. The Front Panel provides you
access to applications and workspaces. See Chapter 3 for
information on the Front Panel.

A dxsession Session starts the DECwindows Motif Session
Manager, (dxsession). Formerly, this was the default graphical
user environment available on the Digital UNIX system. When
you start a DECwindows Motif session, a console window and the
Session Manager menu bar are displayed. The console displays all
system messages received during a session. The Session Manager
displays menus that you can use to start applications and
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customize your environment. Chapter 6 describes the differences
between a DECwindows Motif session and a CDE desktop
session. For information on working in the DECwindows Motif
environment, see the DECwindows User’s Guide.

A Failsafe Session opens a terminal window and starts the
Window Manager. Logging into a Failsafe Session is useful when
you want to execute commands before starting a desktop session.
For example, you may have a problem that you want to fix before
beginning a session.

The Command-line Login Session suspends the desktop and
provides a way for you to work in the base operating system
environment, an environment without windows. Because the
Login Manager is not active and the X server is not running, a
login screen is not displayed.

2.3.3 Resetting the Login Screen Option
If you decide that the options you selected are not the ones you
want, you can reset the login screen. Resetting the login screen
returns all options selected back to their default values.

2.4 Pausing a Session
If you plan to be away from your current session for a time, you
can pause your session indefinitely. Pausing your session locks
your workstation, but applications that were started continue to
run. Each environment that you work in offers a different method
of pausing a session:

• To pause a Regular Desktop Session, click on the Lock control
on the Front Panel.

• To pause a Failsafe Session, type the dxpause command at
the command line prompt.

• To pause a dxsession Session, click on the Session menu, then
click on Pause.

When you pause your session, a blank screen is placed over the
workstation screen and a dialog box is displayed stating that the
display is locked. You have the option of displaying other screen
savers by using the Style Manager. Enter your password in the
text-entry box to resume your session.
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2.5 Ending a Session
Each environment that you work in offers a different method of
ending a session:

• To end a Regular Desktop Session, click on the Exit button on
the Front Panel. A dialog box appears that asks you to
confirm the end of session. You can choose to continue with
the log out process, cancel the logout process, or select help.

All settings from this session are saved and restored during
your next session, including all applications that support save
and restore. That is, all applications that are opened when you
exit a session, which support save and restore, are opened
when you log in again. For some applications, all the work is
restored, while for others, only the main screen of the
application is restored.

If you changed your startup options using the Style Manager
Startup control specifying other options, the state of your next
session depends on your selection.

• To end a Failsafe Session, type the exit command in a
terminal emulator window.

• To end a dxsession Session, click on the Session menu, then
click on Exit. A dialog box appears that asks you to confirm
the end of session and save any settings that changed.

• To end a Command Line Login Session, type Exit at the
command line prompt.
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3Using the Front Panel3333333333333333333333
The Front Panel is the horizontal display located at the bottom of
your workspace. It displays the controls (or tools) that you use to
start applications, manage tasks in a desktop session, or change
workspaces. Each control is represented by an icon that indicates
its purpose.

This chapter provides descriptions of the controls available by
default on the Front Panel and discusses how to use subpanels and
workspaces.

3.1 Touring the Front Panel
By default, the Front Panel provides several controls that you can
use to manage your desktop sessions. Some controls, such as the
Clock, are indicators only. Indicators do not perform actions.
Others, such as the Mail control, perform actions. That is, you
can use mail to send and receive messages.

The controls available on the Front Panel are described in Table
3-1. For detailed information on the use of each tool, see the
Common Desktop Environment: User’s Guide.

Table 3-1:   Front Panel Controls
222222222222222222222222222222222222222222222222222222222
Application Use of Application222222222222222222222222222222222222222222222222222222222
Clock Displays the time of day in analog format.

Clicking on this control does not perform
an action.

Calendar Displays the current month and day. Use
this application to schedule appointments
and To Do Items, set reminders, browse
other calendars, and schedule group
appointments. Dropping an appointment
file on the Calendar control adds the
appointment to your calendar database.



Table 3-1:   (continued)
222222222222222222222222222222222222222222222222222222222
Application Use of Application222222222222222222222222222222222222222222222222222222222
File Manager Provides a view of directories (folders) and

files. Dropping a directory on the File
Manager control opens a view of that
directory.

Text Editor Opens a Text Editor window where you can
create letters or notes. Dropping a file on
the Text Editor icon opens that file in a
Text Editor window.

Mailer Starts the Mailer application. Use this
application to send, receive, save, and
forward mail messages. Dropping a file on
this control displays the contents of the file
in a New Message window.

Lock Pauses a session indefinitely. Pausing a
session locks the workstation display, but
applications continue to run. To resume a
session, enter your password.

Workspace Switches Changes workspaces. Use this switch to
move to different work areas. There are
four workspaces by default.

Busy Light Indicates that an action is being performed.
For example, when you start an application,
the light blinks. Once the call to the
application is complete, the busy light stops
blinking. Clicking on this icon does not
produce an action.

Printer Displays the status of the default printer.
Dropping a file on the Printer icon, prints
that file on the default printer.

Exit Starts the logout process for a session.

Style Manager Opens the Style Manager application. Use
this application to change the characteristics
of your environment.

Application Manager Starts the Application Manager, which is a
container for applications and other tools
available on your system.

Help Manager Displays the top level of available online
help information. Dropping a master help
volume file (*.sdl) onto the Help
Manager opens a help viewer window and
displays the contents of that volume.
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Table 3-1:   (continued)
222222222222222222222222222222222222222222222222222222222
Application Use of Application222222222222222222222222222222222222222222222222222222222
Trash Can Opens the Trash Can application. Use this

application to delete files. Dropping a file
on the Trash Can control moves the file to a
discard directory.222222222222222222222222222222222222222222222222222222222

3.2 Using Front Panel Menus and Workspaces
A view of the Front Panel shows that some controls by default
have arrows above them. Arrows indicate that a subpanel is
available. A subpanel is a menu that provides access to other
controls which you can use to manage your desktop session. For
more information on subpanels, see Section 3.2.1.

All controls on the Front Panel have a pop-up menu. Usually,
pop-up menus contain a control that you can use to add or remove
a subpanel, and a control to view an online help volume.
Controls, that perform actions, such as the Text Editor, also
provide a control on the pop-up menu that you can use to start that
action from the menu. See Table 2-2 for general information on
using menus.

To manage workspaces, you can use the Workspace Menu. The
workspace menu is a pop-up menu, which you can use to manage
windows, the Front Panel, and more. See Section 3.2.2 and
Section 3.2.3 for more information.

3.2.1 Using Subpanel Menus
Subpanel menus provide you further access to other tools and
controls for the Front Panel. Each subpanel on the Front Panel
also provides an Install Icon, which you can use to add other tools
to the subpanel.

By default, there are three subpanels available from the Front
Panel. They are the Personal Applications, Personal Printer, and
Help Manager subpanels. To open a subpanel, point to a control
icon that has an arrow above it, then click on mouse button 1.

The following sections discuss the default subpanels. For more
information on using and customizing the subpanels, see the
Common Desktop Environment: User’s Guide.

Using the Front Panel 3–3



3.2.1.1 Personal Applications Subpanel

The Personal Applications subpanel contains applications that you
use frequently. It is located above the Text Editor control on the
Front Panel. The menu items available on this subpanel include:

• Install icon

Use this control to add items to the Personal Applications
subpanel. To add an item, drag an icon from the File Manager
or Application Manager onto the Install Icon, then release.
The item is then added to the subpanel.

• Text Editor

Use this control to create text files such as notes and messages.
This control is a duplicate of the Text Editor control available
on the Front Panel.

• Terminal

Use this control to start the terminal emulator, dtterm,
which emulates that portion of a VT220 terminal that is
consistent with ANSI and ISO standards. By using the
terminal emulator, you can enter operating system commands,
UNIX commands, copy and paste text, or communicate with
remote systems.

Note

In certain locales, the DECwindows Motif
terminal emulator dxterm is available on this
subpanel instead of dtterm. See Chapter 9 for
more information.

• Icon Editor

Use this control to create or modify either bitmap or pixmap
image files. Icons can be dropped onto the Icon Editor and
used as a base for creating a new image.

3.2.1.2 Personal Printers Subpanel

The Personal Printers subpanel lists default printers. It is located
above the Printer control on the Front Panel. The menu items
include:

• Install icon

Use this control to add items such as other printers to the
Personal Printers subpanel. To add an item, drag an icon
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from the File Manager or Application Manager onto the Install
Icon, then release. The item is then added to the subpanel.

• Default Printer

Use this control to display the status of print jobs on the
default printer. If you drag and drop a file on this menu item,
the job is printed on the default printer or a printer of your
choice.

• Print Manager

Use this control to obtain a view of available printers on the
system. This control is the same as the Print Manager control
on the Front Panel.

3.2.1.3 Help Subpanel

The Help Manager subpanel lists other available help volumes. It
is located above the Help Manager control on the Front Panel.
The menu items include:

• Install icon

Use this control to add items to the Help Manager subpanel.
To add an item, drag an icon from the File Manager or
Application Manager onto the Install Icon, then release. The
item is then added to the subpanel.

• Help Manager

Use this control to display the top level of help information.
This control is the same as the Help Manager control on the
Front Panel.

• Desktop Introduction

Use this control to display the introductory help volume for the
desktop.

• Front Panel Help

Use this control to display help for the Front Panel.

• On Item Help

Use this control to obtain on-item help for controls in the
Front Panel. To obtain on-item help, click on the On Item
Help control. The pointer turns into a question mark (?).
Position this question mark over an object on the Front Panel,
then release. Help is then displayed for that object.
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3.2.2 Using Workspaces
Workspaces offer you a method of organizing your work into
categories. To move between workspaces, you use the workspace
switch available on the Front Panel. By default, the workspace
switch has four buttons, labeled one through four. To move
between workspaces, click on one of the workspace buttons.

Each workspace offers you a view of the Front Panel. Thus, you
can easily locate applications and tailor each workspace to suit
your needs. Often it is useful to rename a workspace. To rename
a workspace:

1. Click on the workspace button that you want to change. The
workspace selected is displayed.

2. Click on the workspace button again. This changes the button
to an input text field.

3. Enter the new name in the text field and then press the Return
key.

You can also use the workspace button pop-up menu to rename,
add, or remove workspaces. To use the workspace button pop-up
menu:

1. Point to the workspace button that you want to change and
press mouse button 3.

2. Choose the option you want from the pop-up menu.

If you add a workspace, it is labeled New. You can rename the
workspace using either of the previous methods.

If you remove a workspace that contains windows, the windows
are moved to the next workspace. If it is the last workspace and it
has windows, removing the workspace causes all windows to be
moved to the first workspace (labeled one by default).

3.2.3 Using the Workspace Menu
CDE provides a Workspace menu. The Workspace menu is a
pop-up menu that contains items for managing each of your
workspaces. To open the Workspace menu, point to any blank
area on your screen, then click on mouse button 3. Use the
Workspace menu to:

• Manipulate the location of windows

• Refresh the display

• Minimize or restore the Front Panel
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• Restart the Window Manager (if you customized configuration
files)

• Move objects between workspaces

• Log out of the session

You can customize the Workspace menu by adding or removing
items as you choose. See the Common Desktop Environment:
User’s Guide for more information.
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4Managing the Desktop and
Applications3333333333333333333333

The CDE desktop provides a File Manager, Style Manager, and
Application Manager. Each provides you with a method of
managing and customizing your desktop environment.

The icon-based File Manager is used to manage directories
(folders) and files on your system. That is, you can create new
directories and files, locate directories and files, and remove
directories and files. Because it is integrated with the desktop, you
can drag objects from the File Manager to use in other
applications.

The Application Manager is used to access other tools that are
available on your system. From the Application Manager, you can
start applications, or even move applications from the Application
Manager to the Front Panel.

The Style Manager is used to customize the appearance of your
desktop. You can change colors, background patterns, window
attributes, mouse and keyboard attributes, and select how your
session begins and ends.

The following sections discuss in more detail how to use the File
Manager, Application Manager, and Style Manager.

4.1 Managing Files and Folders
The File Manager is an application that you can use to manage
directories (folders) and files on your system. A directory can
contain subdirectories, files, and applications, and each is
represented by an icon in the File Manager. The structure of
directories under the File Manager is the same as the structure in a
nongraphical environment. In fact, you can display files by name
only.

When the File Manager is started, a window is opened that
displays the current directory path, menus, a viewing area, and the
directory contents, represented by icons in the viewing area. A
status line specifies the number of objects in the directory you are
viewing.



By using the File Manager menus, you can change, move and
rename directories and files. You can also perform actions on
certain files or specify how they are viewed. The following
sections discuss the options available in the File Manager menus.
For more information on other methods of managing files, see the
Common Desktop Environment: User’s Guide.

4.1.1 Using the File Manager File Menu
Use the File menu to rename directories or files and to move
directories and files within the File Manager.

Table 4-1:   File Manager File Menu
222222222222222222222222222222222222222222222222222222
Menu Item Purpose222222222222222222222222222222222222222222222222222222
New Folder... Opens a dialog box that you can use to

create new directories. If you do not
specify a pathname, the directory is created
in the current directory.

New File... Opens a dialog box that you can use to
create new files. If you do not specify a
path, the file is created in the current
directory.

Go Home Changes to your home directory. The
viewing area displays all files and
directories in your home directory.

Go Up Changes to the Parent Folder. That is, the
view changes to the directory above your
current display.

Go To... Opens a dialog box where you can specify
the directory you want to view.

Find... Opens a dialog box where you can specify
a directory or file that you want to locate.
Wildcards are permitted in directory and
file specifications. If you do not know the
name of the file, you can specify a search
by file content. Files that are located are
listed by name. You have the option of
placing the file on the workspace or
viewing the contents of the file in the File
Manager.
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Table 4-1:   (continued)
222222222222222222222222222222222222222222222222222222
Menu Item Purpose222222222222222222222222222222222222222222222222222222
Open Trash Starts the Trash application. You can use

this application to delete directories or files
from the File Manager.

Open Terminal Opens a terminal emulator window. You
can use this window to create new files or
perform other tasks related to file
management.

Close Exits from the File Manager.222222222222222222222222222222222222222222222222222222

4.1.2 Using the File Manager Selected Menu
Use the Selected menu to perform actions on specified directories
or files. You must first select a directory or file before initiating
an action. To select a directory or file, click on your selection in
the File Manager window.

Table 4-2:   File Manager Selected Menu
2222222222222222222222222222222222222222222222222222222222222
Menu Item Purpose2222222222222222222222222222222222222222222222222222222222222
Move To... Opens a dialog box that you can use to

move a directory or file to a new
destination.

Copy To... Opens a dialog box that you can use to
copy a directory or file to a new
destination.

Copy as Link... Opens a dialog box that you can use to
copy a directory or file to a new
destination, which is to be used as a link.

Put in Workspace Places the selected directory or file in the
workspace.

Put in Trash Marks the selected directory or file for
delete.

Rename... Opens a dialog box that you can use to
specify a new name for the directory or file.

Change Permissions... Opens a dialog box that you can use to
change the permissions on the selected
directory or file.
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Table 4-2:   (continued)
2222222222222222222222222222222222222222222222222222222222222
Menu Item Purpose2222222222222222222222222222222222222222222222222222222222222
Select All Marks all directories and files in the current

directory for an action that you specify.

Deselect All Causes all directories and files marked for
an action to be unmarked.

Open in Place Displays the contents of the directory or file
in the current File Manager window.

Open New View Displays the contents of the directory or file
in a new File Manager window.

Print Submits to the print queue the selected
directory or file.2222222222222222222222222222222222222222222222222222222222222

4.1.3 Using the File Manager View Menu
Use the View menu to manipulate how directories and files are
displayed.

Table 4-3:   File Manager View Menu
2222222222222222222222222222222222222222222222222222222222222
Menu Item Purpose2222222222222222222222222222222222222222222222222222222222222
Open New View Opens a new File Manager window.

Set View Options... Opens a dialog box that you can use to
specify the format of headers, placement of
files, and how they are viewed.

Save as Default Options... Opens a dialog box that you can use to save
the current settings for the File Manager.

Show Hidden Objects Displays all hidden directories and files in
the current directory.

Set Filter Options... Displays the Set Filters Options dialog box,
which you use to specify files you want
hidden based on data type or name.

Clean Up Sorts and arranges objects in the current
directory into columns and rows.

Update Refreshes the File Manager display adding
any new directories or files that have been
created since the application was started.2222222222222222222222222222222222222222222222222222222222222
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4.2 Managing Applications
The Application Manager is a container for applications and other
tools on your system. Applications are placed under the
Application Manager when your system is installed, the system
administrator adds them, or you can add them to this area.

4.2.1 Accessing Built-in Application Groups
When you start the Application Manager, a set of application
groups is displayed in the main window. Each application group
is a directory that can contain one or more controls or
subdirectories.

The default application groups are as follows:

• Desktop_Apps

Contains the desktop applications such as the File Manager,
Style Manager, and Calendar applications.

• Desktop_Tools

Contains the commonly used tools for desktop administration
such as the vi text editor, Check Spelling, and Reload
Application.

• Information

Contains icons that represent frequently used help volumes.

• System_Admin

Contains the tools used by a system administrator to manage
the system.

4.2.2 Using the Application Manager Menus
The Application Manager is actually a File Manager view of a
special directory on the system. Unlike the File Manager, the
directories and controls in this view group applications in related
groups, and all files contained in these groups are data files, read
me files, templates, and actions. The menus for both the
Application Manager and File Manager are closely related. For
information on using the Application Manager menus, see the
descriptions of the File Manager menus in Section 4.1.
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4.2.3 Running an Application from the Application Manager
To run an application from the Application Manager, double click
on the application group’s icon to display the contents, then
double click on the application that you want to start.

4.3 Customizing Your Environment
The Style Manager is an application that you can use to customize
your environment. When the Style Manager is started, a window
is opened that displays several controls. Each control is
represented by an icon, and collectively these are used to
customize screen appearance, system characteristics, and startup
and logout behavior. Each control opens a dialog box that offers a
variety of options.

The Common Desktop Environment: User’s Guide provides
detailed instructions on using the Style Manager. The following
sections discuss these options.

4.3.1 Changing Screen Appearance
The Style Manager provides three controls that you can use to
change the appearance of your workspace. These include the
Color, Font, and Backdrop controls.

Use the Color control to set the colors displayed by windows and
applications. A default list of color palettes is provided, and each
can be previewed before being applied to the desktop. By using
the color control, you can do the following:

• Select a palette

• Modify an existing palette

• Choose a color from the workspace

• Create a custom palette

• Delete a palette

• Change the number of colors used on the desktop

Use the Font control to change the size of fonts used by your
applications and windows. The fonts available to you are
determined by your display type. By using this control, you can
preview all selected fonts before applying them to the desktop.
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Use the Backdrop control to change the background pattern of
your workspace. This control provides a list of several patterns
that you can choose from and each can be previewed in a viewing
area before you apply them to the desktop. If you prefer to view
the root window, select the No Backdrop option.

4.3.2 Setting System Characteristics
The Style Manager provides five controls that you can use to set
system characteristics. These include the Keyboard, Mouse, Beep,
Screen, and Window controls.

Note

Not all keyboards support changing the keyclick
volume or beep.

Use the Keyboard control to set the key click volume and
character repeat capability. The key click volume determines how
loud key clicks are as you type. If you prefer not to hear key
clicks, the volume can be turned off. The character repeat
capability determines whether or not a key repeats its action for as
long as it is pressed.

The Mouse control is used to select the following:

• Order of button settings

Sets the behavior of mouse buttons 1 and 3. By default, the
mouse is set up for persons who use their right hand. The
actions of mouse buttons 1 and 3 can be reversed for persons
who are left handed.

• Double click speed

Sets the maximum interval that can pass between the first and
second click of the mouse to signal a double click action.

• Pointer acceleration

Sets the speed with which the pointer moves across the
display.

• Pointer threshold

Sets the distance in pixels that the pointer moves at a slow
speed before accelerating.
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The Beep control is used to set how audible a beep is, the pitch of
the beep, and the duration. The volume can be turned off, which
cancels the beep.

The Screen control specifies whether or not a screen saver is
placed on the screen after a certain time interval. You can choose
to have a blank screen or you can select from the list of screen
savers available. By using the Screen control, you can also
specify whether the screen is locked in these time intervals.

The Window control alters characteristics such as how the window
acquires focus, if a window raises when it receives focus, and
whether or not to use icon boxes.

4.3.3 Specifying Startup and Logout Behavior
The Style Manager provides a Startup control that you can use to:

• Specify whether you want to resume your current session or
start a home session

• Specify whether or not a logout confirmation is displayed

The session you are working in is referred to as your current
session. By default, the desktop saves your current session when
you log out. This session is resumed when you log into your next
session. By using the Startup control, you have a choice of
returning to the current session or starting a home session. A
home session displays the same settings each time you log into the
system. That is, a home session remains the same regardless of
what you do in the current session.

A logout confirmation queries you before ending a session. You
can optionally specify whether or not you want a confirmation
message to appear. If you set the logout confirmation to Off, you
are not given the option of canceling the logout process. By
default, you are prompted to end a session.
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5Using Digital Applications3333333333333333333333
There are several Digital desktop applications and a suite of
Digital system management applications, referred to as SysMan,
that have been integrated into the Common Desktop Environment
(CDE). These applications are available from the Application
Manager.

This chapter describes how to start applications and how to run
applications across the network. It also introduces the Digital
desktop applications and system management applications that are
available.

5.1 Starting Applications
The desktop applications and the suite of system management
applications are located in /usr/bin/X11. You can start these
applications from the Application Manager or you can start them
in a terminal emulator window by using the command name.

To start the desktop applications from the Application Manager:

1. Click on the Application Manager control on the Front Panel.

2. Double click on the application group you want to access.

To access the Digital desktop applications, double click on the
desktop_app control.

To access the suite of Digital System Management application,
double click on System_Admin, then double click on the
System_Management_Utilities.

3. Double click on the application that you want to start.

To start an application from a terminal emulator window, you
must include the full pathname of the command, unless you add



/usr/bin/X11 to the path in your .dtlogin or
.dtprofile file. For example, to start Image Viewer from the
command line, type the following:
$ /usr/bin/X11/dximage &

The ampersand (&) at the end of the command line causes the
application to run in the background, freeing you to perform other
tasks from the same terminal window.

5.2 Running Applications Across the Network
In your daily work, you might want to run an application that is
not installed on your workstation. If you have network access,
and an account on the system where the application is installed,
you can run the remote application and display it on your
workstation. Although the application is remote to your system, it
appears to be running from your workstation.

Before you run a remote application, you must authorize access to
your workstation and enable the display as described in the
following sections. You can also use the Host Manager to display
remotely run applications. See the Host Manager online help
volume for more information.

5.2.1 Authorizing Access to your Workstation
To display remotely run applications on your local system, you
must provide the remote host access to your display. You can use
the xhost program to authorize access. For example, if the
hostname of the remote machine is galaxy, enter the following
from your system:
$ xhost +galaxy

The hostname, galaxy, is then added to the list of hosts that
have access to your machine.

5.2.2 Enabling the Display
Once you have authorized the remote system access to your
workstation, log into the remote system, and specify where you
want to display the remotely run application.
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The command line you enter to enable the display varies
depending on the operating system you are using, and the shell
you are using if the remote host is an ULTRIX or Digital UNIX
system. Use one of the following methods to enable the display:

• If the remote host is an ULTRIX or Digital UNIX system and
you use the C shell, enter the following at the system prompt:
setenv DISPLAY workstation:0

• If the remote host is an ULTRIX or Digital UNIX system and
you use the Bourne or Korn shell, enter the following at the
system prompt:
DISPLAY=workstation:0
export DISPLAY

• If the remote host is an OpenVMS system, enter the following
at the system prompt:
set display/create/node=workstation

In the previous example, the OpenVMS network host is
presumed to be DECnet. If the OpenVMS network host is
running Transmission Control Protocol/Internet (TCP/IP), you
can use the TCP/IP network transport as follows:
set display/create/transport=tcpip/node=workstation

If the name of your workstation appears in lowercase in the
OpenVMS TCP/IP database file, you must enclose the name of
your workstation in double quotes (""). If it does not, do not
use quotes. Use the hostname command to see how your
workstation name is entered into the database file.

In the previous examples, workstation is the hostname of the
machine where you want the remote application to display.

Once you have authorized access to your system and enabled the
display, you can run the application from the remote machine by
using the command name as described in Section 5.1. The
application then displays on the system you specified.
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5.3 Using Digital Desktop Applications
Several Digital desktop applications have been integrated into
CDE to provide greater flexibility in using Digital UNIX. Table
5-1 highlights these applications.

Table 5-1:   Digital Desktop Applications
2222222222222222222222222222222222222222222222222222222222222
Application Use of Application2222222222222222222222222222222222222222222222222222222222222
Differences Provides a graphical display of differences

between two files.

Image Viewer Displays the contents of documents that are
in specific formats such as GIF, JPEG, and
TIFF.

Input Method Changes how keystrokes are interpreted by
the operating system.

Keyboard Options Offers a choice of options that you can use
to customize your keyboard.

Keycaps Shows a graphical display of a keyboard
with keycaps drawn according to the
current server keymap and can be used to
start the Keymaps application.

Print Screen Captures a portion of your screen or your
entire screen. The screen capture can be
directed to a file, printer, or both.2222222222222222222222222222222222222222222222222222222222222

Note

The Input Method (dtimsstart) application is
located in /usr/dt/bin and is not included in the
Application Manager under desktop_apps. To start
this application, see Section 5.3.3.

Some of the applications described here are advanced tools that
address special needs. Such applications are not intended for
everyday use.
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5.3.1 Using Differences
Differences is a graphical interface to the diff command. By
using Differences, you can compare two ASCII text files line by
line, and then browse through a graphical display of these
differences.

Starting the Differences application opens a window that has two
empty text regions. The text regions will later contain the
contents of the files you are comparing. The title bar specifies the
application name and the window number. If it is the first
Differences window opened, the window is numbered zero (0).
Subsequent Differences windows that you open are numbered
sequentially to prevent confusion between the windows.

Use the Differences menus to select files to compare, display the
differences, and change the attributes of the display. The
following sections describe the Differences menus and discuss how
to move between the differences in files.

5.3.1.1 Using the Differences File Menu

The following table describes the options available in the
Differences File Menu:
222222222222222222222222222222222222222222222222222222
Menu Item Description222222222222222222222222222222222222222222222222222222
Open... Opens two dialog boxes titled Right File

and Left File. Use these dialog boxes to
specify the files you want to compare.

Exit Closes the Differences application. You are
prompted to save settings.222222222222222222222222222222222222222222222222222222

When you select the Open... menu item, each dialog box lists the
files in your current directory (folder). You can select a file from
that directory, or change to another directory. Changing
directories in one dialog box does not affect the contents of the
other dialog box. You must select a file from each dialog box for
the left and right text regions of the Differences window.

Text does not appear in the text regions until you specify how it is
to be displayed using the Differences menu.
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5.3.1.2 Displaying Differences

The Differences application window has a left and right text region
window. Once you select two files to compare, you can specify
where the files are displayed. Use one of the following options
from the Differences menu to display text for comparison:
2222222222222222222222222222222222222222222222222222222222222
Menu Item Description2222222222222222222222222222222222222222222222222222222222222
Do Differences Displays files in the text regions of the

main window.

Do Differences in New Opens a new window and displays selected
files in the text regions of the new window.2222222222222222222222222222222222222222222222222222222222222

If you display files in the Differences main window, then later
choose to compare a different set of files in the main window, the
contents of the text regions are overwritten by your latest
selection. If you display files in a new window, the number
following the title is incremented by one. Files displayed in the
main window are unaffected.

If there are no differences between the selected files, the files are
not in ASCII format, or you specified a directory instead of a file,
a message dialog box is displayed.

5.3.1.3 Changing Display Characteristics

Use the Differences Options menu to specify attributes that change
the display of differences.
2222222222222222222222222222222222222222222222222222222222222
Menu Item Description2222222222222222222222222222222222222222222222222222222222222
Linked Vertical Scrolling Off
Linked Vertical Scrolling On Turns vertical scrolling on or off.

By default, linked vertical scrolling
is enabled. That is, scrolling
through one text region affects the
other text region in the same
manner.
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2222222222222222222222222222222222222222222222222222222222222
Menu Item Description2222222222222222222222222222222222222222222222222222222222222
Linked Horizontal Scrolling Off
Linked Horizontal Scrolling On Turns horizontal scrolling on or

off. By default, linked horizontal
scrolling is enabled. That is,
scrolling through one text region
affects the other text region in the
same manner.

Render Differences as Lines
Render Differences as Polygons Emphasizes the differences

between files as polygons or lines.
By default, differences are
displayed as polygons. Polygons
appear as filled regions.

No Diff Line Numbers
Display Diff Line Numbers Enables or disables the display of

line numbers. By default, line
numbers are enabled. Line
numbers specify the location in
each file where differences occur.2222222222222222222222222222222222222222222222222222222222222

5.3.1.4 Moving Between Differences

Differences in files are highlighted and line numbers specify the
location of the difference in each file by default. Common text
between the file is not highlighted. To move between differences
in the displayed files, use the scroll bars or use the Next Diff and
Prev Diff push buttons located at the bottom of the window.

Each text region has a set of vertical and horizontal scroll bars.
By default, moving the scroll bars affects both text regions. The
Next Diff push button does a forward search through the file to the
next difference. The Prev Diff push buttons performs a backward
search through the file to the previous difference.

To change the display characteristics when comparing files, see
Section 5.3.1.3.

5.3.2 Using Image Viewer
The Image Viewer application can be used to view a variety of
image files including: GIF, JPEG, TIFF, XPM, XBM, PPM,
BMP, and PCX. When Image Viewer is started, a window is
opened that contains an optional toolbar, menu bar, and optional

Using Digital Applications 5–7



scroll bars that provide horizontal scrolling, vertical scrolling, or
both. In the Image Viewer window, you can display images in
various formats and manipulate the image views using either the
toolbar icons or menus.

For detailed information on using Image Viewer, see the online
help volume. To access the online help volume, start Image
Viewer, then click on the Help menu.

5.3.3 Using Input Methods
The Input Methods application is a tool for advanced users. You
can use this application to specify an input method and to change
how keystroke characters are interpreted by the system. For
example, Asian (multibyte) characters such as Japanese Kanji or
Chinese Hanzi characters can be entered from the keyboard by
using this application. To start this application, follow these steps:

1. Open a terminal emulator window.

2. Enter the following:
% /usr/dt/bin/dtimsstart

When the Input Methods application starts, a dialog box lists
options for Style Preference and Input Methods. The following
sections describe these options.

5.3.3.1 Selecting Style Preference Options

Style Preferences specifies the keyboard behavior to use when
entering multiple keystrokes. Entering multiple keystrokes to
compose a single character is called preediting. The following
table defines the preediting modes.
222222222222222222222222222222222222222222222222222222
Option Description222222222222222222222222222222222222222222222222222222
Over the Spot Displays data in an input box that is

positioned over the text insertion point.

Off the Spot Displays data in an input box. The input
box window is not located over the
insertion point, but it is often located at the
bottom of the application window.

Root Window Displays data in a preedit window that is
outside the application window.
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222222222222222222222222222222222222222222222222222222
Option Description222222222222222222222222222222222222222222222222222222
On the Spot Displays data in the application window.

Text is moved in the application window to
enable the insertion of the preedit data at
the text insertion point.222222222222222222222222222222222222222222222222222222

To select a preediting style, click on the preferred style then press
the Apply button. Depending on the Input Method you use, not
all preediting modes are available.

5.3.3.2 Selecting an Input Method

The operating system has a default Input Method server. If you
want to specify an Input Method server other than the default,
select the Other option listed under Input Methods, then click on
the text entry box and enter the name of your server.

The name of an input method is governed by the input method
server. The name should be the same as the setting of the
XMODIFIERS environment variable.

5.3.4 Using Keyboard Options
The Keyboard Options application is a tool for advanced users.
Use this tool to customize keyboard settings. This tool is used
usually after the initial setup of your system only to set options
that cannot be specified during the installation.

When the Keyboard Options application is started, a dialog box
appears with several options. The following sections describe
these options and then describe how to save and load settings.

5.3.4.1 Specifying Keyboard Attributes

The Keyboard Options dialog box lists several options that you
can use to set attributes for your keyboard. The following table
lists these options.
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22222222222222222222222222222222222222222222222222222222222
Option Description22222222222222222222222222222222222222222222222222222222222
Keyboard Type Displays a list of available keyboard types.

Keyboard types are located in the
/usr/lib/X11/keymaps file. To highlight the
default keyboard type, click on the System Default
button.

Language Type Displays a list of available language types if you
have the X Keyboard Extension (X11R6 XKB)
installed on your system. To highlight the default
language type, click on the System Default button.

Lock Key Specifies how keys are interpreted when you use the
Caps Lock key. You have the option of selecting a
Caps Locked or a Shift Lock state. The default lock
state is Caps Lock.

A Caps Locked state has the following behavior:

• Typed letters appear in uppercase.

• Typed numbers appear as numerics.

• Symbols above numbers appear when you
press and hold the shift key while
pressing the corresponding symbol.

A Shift Lock state has the following behavior:

• Typed letters appear in uppercase.

• Typed numerics display the symbol above
the numeric.

Keyboard Style Specifies whether the keyboard exhibits the behavior
of a typewriter or data processor. This option is
available only if the Keyboard type supports these
modes.

Keycaps... Starts the Keycaps Application, which is used to
modify keyboard mappings.22222222222222222222222222222222222222222222222222222222222

5.3.4.2 Saving and Loading Settings

Customized keyboard settings created with this application are in
effect once you press the OK or Apply button. When you end a
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session, settings are saved in the file $HOME/DXkeyboard. To
use these settings during your next session, edit your .profile,
.cshrc, or .login file and add the following line:

/usr/dt/bin/dxkeyboard -load

5.3.5 Using Keycaps
The Keycaps application is a tool for advanced users. Use this
application to display and edit keyboard mappings. The following
sections discuss the keyboard display, simulating key events,
modifying settings, and by using the Commands menu.

5.3.5.1 Displaying the Keyboard

When you start this application, a window is opened that contains
a status list in the top left corner and a drawing of a keyboard at
the bottom of the window. The title bar of the window specifies
the type of keyboard displayed.

The status list provides information on keycodes (KeyCode), key
symbols (KeySym), modifiers, and the auto repeat (AutoRepeat)
functions of each key.

Table 5-2:   Keycaps Status List
22222222222222222222222222222222222222222222222222
Status Item Use of Option22222222222222222222222222222222222222222222222222
KeyCode Displays the text printed on each key and

the keycode generated by that key.

KeySym Displays symbols generated by this key in
its current state.

Modifiers Displays bits that modify the behavior of
this key. For example, modifiers include
keys such as the Shift or Control key.

AutoRepeat Specifies whether or not the key, when
typed, repeats its action until depressed.22222222222222222222222222222222222222222222222222

The keyboard drawing shows all available keys on the keyboard,
and printed on each is the character and hexadecimal keycode
generated by that key. Information in the status list changes as
you move the mouse pointer over each key in the keyboard
drawing.
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5.3.5.2 Simulating Key Events

You can press and release a key on the keyboard drawing by using
the mouse, keyboard attached to your workstation, or both. When
you press a key using the mouse or keyboard, that key is
highlighted. When you release the key, highlighting of the key
stops. This enables you to generate key-chords such as CTRL/C.

To use the mouse to perform key events, follow these steps:

1. Position the mouse pointer over any key.

2. Click on mouse button 1. This highlights the pressed key and
simulates a KeyPress event.

3. Click on mouse button 1 again to release the key. This
simulates a KeyRelease event and the key is no longer
highlighted.

To use the keyboard attached to your workstation to perform key
events, enter any character from your keyboard. As you type keys,
the keyboard display highlights each key typed.

To use both the mouse and keyboard to perform key events,
position the mouse pointer over a character modifier such as
CTRL, then type a character from the keyboard that can be
modified.

5.3.5.3 Modifying Key Settings

To modify key settings, use the pop-up menu provided with the
Keycaps application. The pop-up menu can be used to exchange
keys, duplicate keys, edit key mappings, or restore settings. The
following table describes each menu item.
222222222222222222222222222222222222222222222222222222
Menu Item Description222222222222222222222222222222222222222222222222222222
Exchange Keys Interchanges the behavior of one key for

another.

Duplicate Keys Makes a copy of a key. In duplicating a
key, you are producing two keys that use
the same set of symbols and modifiers. The
first key selected becomes a copy of the
second key.

Edit KeySyms Opens a dialog box that you can use to
change key symbols and modifiers. A list
of modifier bits, and two lists of optional
key symbols are displayed that you can use
to modify current settings.
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222222222222222222222222222222222222222222222222222222
Menu Item Description222222222222222222222222222222222222222222222222222222
Reset to Default Restores the keyboard to its default state.

If you execute this command while
displaying a keyboard other than the
default, the keymaps are scrambled.222222222222222222222222222222222222222222222222222222

5.3.5.4 Using the Keycaps Commands Menu

Use the Commands menu to list alternate keyboard types, reset the
keyboard, save settings, and to exit from the application. The
following table describes the menu items available in the
Commands menu.
222222222222222222222222222222222222222222222222222222
Menu Item Use of Menu Item222222222222222222222222222222222222222222222222222222
Keyboard Lists alternate keyboard types that you can

display. By default, the keyboard type
attached to your workstation is displayed.
Click on any item in this list to change the
keyboard display.

Reset to Default Restores the keyboard to its default state.
If you execute this command while
displaying a keyboard other than the
default, the keymaps are scrambled.

Save Saves all keycaps bindings selected in the
file $HOME/ .dxkeycaps. Changes
remain in effect for your next session.

Exit Closes the Keycaps application. You must
save any changes you want available during
your next session.222222222222222222222222222222222222222222222222222222

5.3.6 Using Print Screen
By using the Print Screen application, you can capture a screen
portion or the entire screen. The screen capture can then be output
to a file, printer, or both.

When the Print Screen application is started, a dialog box is
displayed that offers several options. Once you select the options
you want, use the Print Screen menus to capture the screen and
specify attributes of the screen capture. The following sections
describe the Print Screen options and menus.
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5.3.6.1 Using the Print Screen Options

The Print Screen application offers several options that you can
use to specify how the screen capture is handled. Table 5-3
describes these options.

Table 5-3:   Print Screen Options
22222222222222222222222222222222222222222222222222222222222222222
Option Button Option Description22222222222222222222222222222222222222222222222222222222222222222
Capture Portion of the

Screen
Takes a picture of part of the
screen. The pointer turns to a plus
sign (+). Drag the mouse to
enclose the area you want
captured. This is the default.

Entire Screen Takes a picture of the whole
screen.

Time Delay 0 to 100 seconds Pauses the specified seconds
before capturing a screen. Use the
mouse to move the slider from
zero (0) to 100. Zero (0) is the
default.

Send To File Saves a screen capture to a file.
You can use a default filename or
specify a new filename by using
the Output File Name option. This
is the default.

Print Prints a screen capture on the
default printer (unless otherwise
specified). To actually print the
screen capture, you must select the
Print or Print... option from the
File menu.

Both Saves a screen capture to a file and
prints it on the printer.

Output File
Name

Enables you to specify an output
filename for a screen capture.
Click on the text entry box to enter
a filename. The default filename is
printscreen.ps.

Ribbon Saver Positive Image Captures a screen that looks like a
photograph. This is the default.
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Table 5-3:   (continued)
22222222222222222222222222222222222222222222222222222222222222222
Option Button Option Description22222222222222222222222222222222222222222222222222222222222222222

Negative Image Captures a screen looks like a
photograph negative. A negative
image reverses black and white
areas. If you use this option, you
must also use the Output Color
option to specify either the Black
and White or Grayscale option.

Print
Orientation

Best Fit Prints a screen capture in portrait
mode, if screen capture is longer
than it is wide. Otherwise, prints
the screen capture in landscape
mode.

Portrait Prints a screen capture vertically
across the paper. That is, the
capture is longer than it is wide.
This is the default.

Landscape Prints a screen capture horizontally
across the paper. That is, the
screen capture is wider than it is
long.

Output Color Black and White Captures a screen in black and
white. This is the default.

Color Captures a screen in color. For
use with color monitors only.

Gray Scale Captures a screen in gray scale.
For use with gray scale or color
monitors only.

Fit-to-Paper Scale to Fit Sizes the screen capture to fit as
much of the paper as possible.

Reduce Only Minimizes the size of the screen
capture if the capture exceeds the
paper size.

Crop Excess Prints as much of the screen
capture as possible on the paper
and crops parts that do not fit.
This is the default.

Increase 2:1 Doubles the size of the screen
capture.

Decrease 2:1 Reduces the size of the screen
capture by 50 percent.22222222222222222222222222222222222222222222222222222222222222222

Using Digital Applications 5–15



5.3.6.2 Using the File Menu

Use the File menu to specify print options and exit from the Print
Screen application. The following table describes the menu items
available.
222222222222222222222222222222222222222222222222222222
Menu Item Description222222222222222222222222222222222222222222222222222222
Print Sends the screen capture to the default

printer if you selected Print from the Send
To option. If you selected Both from the
Send To option, the screen capture is
printed to the default printer and saved in
the file specified by the Output File Name
option.

Print... Opens a dialog box that you can use to
specify how the screen capture is printed if
you selected either Print or Both from the
Send To option. By using this menu item,
you can select the number of copies to
print, print orientation, print format, printer
to use, time to print, and whether or not to
delete the file after it is printed. The
Options... button in this dialog box offers
other print attributes you can set including
the name of job.

Exit Closes the Print Screen application after
prompting you to save options.222222222222222222222222222222222222222222222222222222

5.3.6.3 Using the Options Menu

Use the Options menu to specify Sixel options or to save options
set during this Print Screen session. The following table describes
the menu items available.
222222222222222222222222222222222222222222222222222222
Menu Item Description222222222222222222222222222222222222222222222222222222
Sixel Opens a dialog box that lists available sixel

output devices.

Save Saves the current settings of the Print
Screen window for your next session. If
you do not set this option during the
session, you are queried about saving
options when exiting from the application.222222222222222222222222222222222222222222222222222222
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5.4 Using the Digital System Management Applications
Digital UNIX offers a suite of system management applications
called SysMan, which provide a graphical front-end to
administrative commands. These tools have been developed for
the person who administers your system.

Section 5.1 describes how to access and start the SysMan
applications. To use most of these applications, you must have
root privileges. For information on using each application, see the
application’s online help volume. You can access the help volume
by opening an application and clicking on the Help menu.

The suite of SysMan applications are divided into four categories:

• Installation Setup

• Configuration

• Daily Administration

• Monitoring and Tuning

5.4.1 Using Installation Setup
The Installation Setup application is used to set up and perform
either a default or custom installation for your system. For more
information, see the online help volume.

5.4.2 Using the Configuration Applications
There are seven configuration applications available for use. Table
5-4 provides descriptions of each of these applications.

Table 5-4:   Configuration Applications
2222222222222222222222222222222222222222222222222222222222
Application Description2222222222222222222222222222222222222222222222222222222222
BIND Configuration Configures Berkeley Internet Name Domain

(BIND) services for a single system.

Disk Configuration Manages the configuration of disks on the
system.

Mail Configuration Sets up the routing and delivery of mail for
the system.

Network Configuration Configures and manages the Transmission
Control Protocol/Internet Protocol (TCP/IP)
on your system.
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Table 5-4:   (continued)
2222222222222222222222222222222222222222222222222222222222
Application Description2222222222222222222222222222222222222222222222222222222222
NFS Configuration Manages Network File System (NFS)

configuration issues.

Printer Configuration Adds, deletes, and modifies printer
configurations for the system’s local and
remote hosts.2222222222222222222222222222222222222222222222222222222222

5.4.3 Using the Daily Administrative Applications
There are nine daily administrative applications available for use.
Table 5-5 provides descriptions of each of these applications.

Table 5-5:   Daily Administration Applications
22222222222222222222222222222222222222222222222222222222
Application Description22222222222222222222222222222222222222222222222222222222
Account Manager Manages user accounts on the system for

both base security systems and Enhanced
Security level systems.

Archiver Copies and stores multiple files to a single,
named archive file or output device such as
a tape or floppy disk.

Display Window Provides a graphical user interface for
running commands.

File Sharing Accesses and exports NFS file systems.

Host Manager Displays icons for all hosts known to the
local system and for those hosts that you
specify. Use the Host Manager to set up
displays and run applications from a remote
system.

License Manager Adds, lists, and deletes software product
licenses.

Power Manager Controls the amount of power consumed by
the system when it is not active. Power
Manager is to be used only with Energy
Star-compatible systems.

Shutdown Manager Performs automated system shutdown.
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Table 5-5:   (continued)
22222222222222222222222222222222222222222222222222222222
Application Description22222222222222222222222222222222222222222222222222222222
System Information Displays and monitors operating system

version, amount of Random Access
Memory (RAM), CPU activity, free
memory, used swap space, file system use,
and disk and tape device names.22222222222222222222222222222222222222222222222222222222

5.4.4 Using the Monitoring and Tuning Applications
There are two monitoring and tuning applications available for
use. Table 5-4 provides descriptions of each of these applications.

Table 5-6:   Monitoring and Tuning Applications
222222222222222222222222222222222222222222222222222
Application Description222222222222222222222222222222222222222222222222222
Kernel Tuner Manages the attributes of loadable kernel

subsystems, handling only the kernel
subsystems that conform to Digital’s
Configuration Management Framework
(CMF).

Process Tuner Displays processes. Using this application,
you can send signals to and change the
priorities of processes.222222222222222222222222222222222222222222222222222

Using Digital Applications 5–19





Part 2 Migrating from DECwindows to CDE3333333333333333333333





6Migrating to CDE3333333333333333333333
The Common Desktop Environment (CDE), based upon Motif and
X11, was developed by major UNIX vendors (Hewlett-Packard,
Sun, IBM, and Novell) to consolidate all the UNIX desktop
interfaces and define a consistent user and development
environment. These vendors formed the Common Operating
System Environment (COSE) consortium, of which Digital is a
member.

CDE is built on existing technologies from the COSE founders
and from the Open Software Foundation (OSF). CDE is not a
replacement for Motif; it is another layer on top of Motif
combining expanded programming utilities and a consistent user
interface.

Under this version of Digital UNIX, CDE is offered as a successor
to the DECwindows Motif interface. This chapter discusses:

• Common components between CDE and DECwindows Motif

• Differences between CDE and DECwindows Motif

This chapter also describes where to go to find more information
on using CDE.

6.1 Common Features Between CDE and DECwindows
Motif

Both CDE and DECwindows Motif operate under the same
premise. Each is comprised of four components that create your
workspace environment. These include the X server, Window
Manager, Session Manager, and client applications. The following
sections highlight these components.

6.1.1 X Servers and Clients
Both CDE and DECwindows Motif use the client/server method of
computing. A component called the X server provides display
services. The X server acts as an intermediary between
applications and the workstation’s display hardware. That is, it



handles output from the clients to the display and forwards input
(from the keyboard or mouse) to the appropriate client for
processing. X clients are applications that make use of the
services provided by the X Window System.

X clients can run on your workstation or on another system.
Because there is built-in networking capability, applications can
run on one system and be displayed on another workstation that
supports the X Window System protocol.

6.1.2 Session Manager
In both the CDE and DECwindows Motif interfaces, logging in to
the system starts the Session Manager. The Session Manager is
the top level interface to the Digital UNIX system. The Session
Manager handles the following:

• Sources appropriate files such as startup scripts

• Sets up search paths

• Gathers available applications and starts the session
applications

• Starts the Window Manager

The CDE Session Manager that starts upon logging into the
system is /usr/dt/bin/Xsession, but the control is handed
to /usr/dt/bin/dtsession after the session has started.

In the DECwindows Motif environment, the Session Manager
started is /usr/bin/X11/dxsession.

6.1.3 Window Manager
For both CDE and DECwindows Motif, the Window Manager
controls the appearance of window frame components, behavior of
windows including the stacking order and focus behavior, key and
button bindings, appearance of minimized windows, and behavior
of menus.

The CDE Window Manager is often referred to as the Workspace
Manager and is based on the OSF/Motif Window Manager. The
default Window Manager for CDE is /usr/dt/bin/dtwm.

The DECwindows Motif Window Manager is
/usr/bin/X11/dxsession.
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6.1.4 X Client Applications
The Digital UNIX operating system includes many sample X
client applications supplied by the X Consortium. Under the
Digital UNIX operating system, DECwindows Motif provides a
set of desktop applications. Likewise, CDE brings to Digital
UNIX a set of applications that provides several features not
available in the DECwindows Motif interface.

Section 7.2 provides more information on using applications in the
CDE interface.

6.2 Differences Between CDE and DECwindows Motif
Although CDE and DECwindows Motif consist of similar
components, CDE offers many features not available in
DECwindows Motif. The remaining chapters in this manual
discuss how to manage your session using CDE as opposed to the
using the DECwindows Motif Session Manager menu. The
following list highlights what is discussed in these chapters:

• Chapter 7 discusses differences in starting and ending a session
and describes how to access applications using CDE.

• Chapter 8 discusses differences in customizing your
environment by highlighting how to complete these actions
using CDE as opposed to DECwindows Motif.

• Chapter 9 discusses internationalization issues such as
selecting a language type, specifying keyboard types, and
differences in the terminal emulator.

• Chapter 10 discusses how to migrate mail folders and calendar
databases to a format that is understood by the CDE Mailer
and CDE Calendar applications respectively.

• Appendix A discusses differences between the CDE Mail and
DECwindows Mail applications.

6.3 Obtaining More Information
The CDE documentation set is available on line and in hardcopy.
To view the CDE documentation set on line, you must use the
Netscape Viewer. You can also obtain information about CDE by
accessing the online help volumes and reference pages.

Section 1.3 describes how to view the CDE documentation set on
line and provides information on accessing online help and
reference pages.
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Differences exist between managing a Common Desktop
Environment (CDE) session and managing a DECwindows Motif
session. This chapter introduces methods you can use to manage
your environment and access applications, and addresses
differences between CDE and DECwindows Motif.

By using CDE, you benefit from an environment that offers the
same features found in DECwindows Motif and more. The
following sections describe the major features of starting and
ending a CDE session, and provides information on managing
your environment as you did using the DECwindows Moitf
Session Manager.

7.1 Starting and Exiting a Session
The CDE Login Screen provides a set of options that were not
available through the DECwindows Motif Login Screen. From the
CDE Login Screen, you can select a session type and a language
type.

There are four types of sessions that you can select:

• A Regular Desktop starts the CDE Session Manager. This is
the default session available.

• A dxsession Session starts the DECwindows Motif Session
Manager.

• A Failsafe Session starts a single terminal window and the
Window Manager.

• A Command-line Session suspends the desktop and provides a
way for you to work in the base operating system environment.

The default language is set by your system administrator; however,
by using the Options menu from the login screen you can also
access other languages that are installed on your system. The
default language is restored when you end your session.



Note

The remaining chapters in this manual discuss a
Regular Desktop session only. See the Common
Desktop Environment: User’s Guide for detailed
information on starting a Failsafe or Command-line
session. See the DECwindows User’s Guide for
information on using DECwindows Motif.

Using DECwindows Motif Session Manager menu, you can
request that certain applications automatically start during each
session. By default, CDE provides automatic save and restore of
your session. All applications that are opened when you exit a
session, which support save and restore, are opened when you log
in again. For some applications, all the work from the previous
session is restored, while for others only the main screen of the
application is restored.

For information on customizing the start and end of a session as
you were able to do using the DECwindows Motif Session
Manager, see Section 8.1.

7.2 Accessing Applications
From the DECwindows Motif Session Manager Application menu,
you can start several applications. Most of these applications have
equivalents in CDE (see Table 7-2) and can be started from the
Front Panel, Application Manager, File Manager, and of course, a
terminal emulator window.

The Front Panel is the narrow window at the bottom of your
screen. It contains a set of applications and controls, which can be
compared to the DECwindows Motif Session Manager menu as it
provides a similar set of services. That is, you can start an
application by clicking on its icon, pause a session by clicking on
the Lock icon, or exit a session by clicking on the Exit icon.
Table 3-1 describes all of the applications and controls located on
the Front Panel.

The icon-based File Manager, available from the Front Panel,
provides a view and easy navigation of a directory hierarchy.
When used with drag and drop actions, you can manipulate
directories and files and interact with other applications. You can
also launch applications using the File Manager.
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The Application Manager, available from the Front Panel, is a
special directory for applications and other tools on your system.
Using the Application Manager, you can launch applications, add
other applications to the Application Manager, or place an
application on the backdrop or on the Front Panel for easier
access.

7.2.1 Managing Applications from the Front Panel
In addition to the Application Manager and the File Manager, the
Front Panel employs some other concepts that are not available in
the DECwindows Motif environment. This includes the use of
subpanels and workspaces.

Any Front Panel icon that has an arrow above it indicates that a
subpanel is available. A subpanel contains a menu of applications
and controls that you can further use to manage your desktop
session. Click on any arrow to display a subpanel menu.

A workspace is the screen display area, which includes the Front
Panel. Using the Workspace Switch (buttons numbered one
through four) on the Front Panel, you can set up and move
between multiple work areas in the same session. Each workspace
includes the Front Panel. You can have up to 64 workspaces.
Click on any workspace button to change workspaces.

To start an application from the Front Panel, click on the
application icon. To start an application from a subpanel:

• Click on the subpanel arrow to display a list of options

• Click on the application icon

7.2.1.1 Adding an Application to a Subpanel

Any application icon that resides in the File Manager or
Application Manager can be added to a subpanel. To add an
application to a subpanel:

1. Open the File Manager or Application Manager and display
the application icon you want to add.

2. Open the subpanel where the application icon is to be added.

3. Drag the icon from the File Manager or Application Manager
and drop it on subpanel’s Install Icon.

Any application icon that is added to a subpanel displays the same
behavior as when it resided in the File Manager or Application
Manager.
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7.2.1.2 Adding a Subpanel Control to the Front Panel

You can add a copy of a subpanel control to the Front Panel for
easier access. To copy a subpanel control to the Front Panel:

1. Open the subpanel that contains the application icon you want
to copy.

2. Point to the application icon you want to add and click on
mouse button 3 to display its pop-up menu.

3. Choose Copy to Main Panel from the pop-up menu.

7.2.1.3 Replacing a Control in the Front Panel

To replace a control in the Front Panel easily, exchange it with a
subpanel control.

1. Open the subpanel of the control you want to replace. If the
control does not have a subpanel control, you can create it:

a. Point to the control in the Front Panel and click on mouse
button 3

b. Select Add Subpanel from the pop-up menu

c. Display the new subpanel

d. Add the control you want to place on the Front Panel to
the subpanel as described in Section 7.2.1.2

2. Point to the control in the subpanel and click on mouse button
3 to display the pop-up menu.

3. Choose Copy to Main Panel from the pop-up menu.

If you had to create a subpanel and you do not want retain it, point
to the Front Panel control icon and click on mouse button 3. You
can then select the Remove Subpanel option.

If you are an advanced user, you can also create or edit a Front
Panel configuration file that changes the characteristics of the
Front Panel. See the Common Desktop Environment: Advanced
User’s and System Administrator’s Guide for more information.

7.2.1.4 Removing Front Panel Customizations

You can remove Front Panel customizations made by using the
Install Icon control or using the Front Panel pop-up menus:

1. Open the Application Manager.

2. Double click on the Desktop_Tools application group.
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3. Double click on Restore Front Panel.

This procedure does not affect customizations made using Front
Panel configuration files.

7.2.2 Starting Applications from the Application Manager
The Application Manager contains a set of built-in application
groups. Each application group is a directory that contains one or
more icons that you can use to open applications. An icon group
can also contain other application files such as data files,
templates, and read me files.

Table 7-1:   Built-In Application Groups
2222222222222222222222222222222222222222222222222222
Group Description2222222222222222222222222222222222222222222222222222
Desktop_Apps Contains the desktop applications such as

the File Manager, Application Manager,
and Calendar applications.

Desktop_Tools Contains commonly used tools for the
desktop administration such as the vi Text
Editor, Check Spelling, and Reload
Application.

System_Admin Contains the tools used by the system
administrator to manage the system.

Information Contains frequently used help volumes.2222222222222222222222222222222222222222222222222222

You can have additional application groups. The previous table
lists those known groups available by default.

To start an application from the Application Manager:

1. Double click on the application group where the application is
located.

2. Double click on the application.

You can also create personal application groups as described in the
Common Desktop Environment: User’s Guide.

7.2.3 Running Applications with the File Manager
The File Manager is predominately used to create, find, and
manage desktop objects such as files, folders, and applications. If
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an application uses data files, you can also start an application
from the File Manager using the application’s data file.

Use one of the following methods to start an application using its
data file:

• Double click on the application’s data file

For example, double clicking on a bitmap file (.bm) starts the
Icon Editor application

• Point to an application’s data file, click on mouse button 3 and
then choose Open from the pop-up menu.

You can also use the drag and drop features with the File Manager
to interact with applications. For example, drag a file from the
File Manager and drop it on the Print Manager to print a file or
drag a help volume with a .sdl extension and drop it onto the
Help Manager to open a help volume.

7.2.4 Using DECwindows Motif Applications
Most of the applications available with the previous version of
DECwindows Motif have equivalents available in CDE. Those
that do not have equivalents in CDE, have been integrated into the
desktop and are available through the Application Manager.

Table 7-2 lists the DECwindows Motif applications, followed by
the recommended application to use, its executable name, and its
location. If for some reason, you want to use a DECwindows
Motif application, which has not been integrated into the
environment, these applications are still available in
/usr/bin/X11.

Table 7-2:   Recommended Applications to Use in CDE
222222222222222222222222222222222222222222222222222222222222222222
DECwindows Recommended
Application Application
Name Name Executable Location222222222222222222222222222222222222222222222222222222222222222222
Bookreader Netscape Browsera netscape Application

Manager
CDE HelpViewera dthelpview Front Panel

(Help Manager)

Calculator CDE Calculator dtcalc Front Panel

Calendar CDE Calendarb dtcm Front Panel

Cardfiler xclipboard xclipboard Application
Manager
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Table 7-2:   (continued)
222222222222222222222222222222222222222222222222222222222222222222
DECwindows Recommended
Application Application
Name Name Executable Location222222222222222222222222222222222222222222222222222222222222222222
CDA Viewer Image Viewerc dximage

Clock CDE Clockd Front Panel

DECterm CDE Terminal dtterm Front Panele

Differences Differencesf dxdiff Application
Manager

Mail CDE Mailerb dtmail Front Panel

Notepad CDE Text Editor dtpad Front Panel

Paint CDE Icon Editor dticon Front Panel
(Text Editor
subpanel)

Print Screen Print Screenf dxprint Application
Manager222222222222222222222222222222222222222222222222222222222222222222

a. See Section 1.3 for information on the CDE documentation set
and online help.

b. Migration tools are available that you can use to convert your
DECwindows Motif mail folders and calendar database to a
format that can be understood by the CDE mail and calendar
applications. See Chapter 10 for information on using these
converters.

c. Digital recommends using Image Viewer (dximage), a
Digital desktop application, which has been integrated into
CDE. It is available from the Application Manager. See
Section 5.3.2 for more information.

d. CDE Clock is an indicator only; it does not perform actions.
To set an alarm, use the CDE Calendar application.

e. Starting the CDE Terminal from the Front Panel consumes
considerable system resources. If you are opening several
terminal emulator windows, start a new terminal emulator from
an existing terminal emulator window. To do this, select the
Window menu, then choose the New option.

f. Both Print Screen and Differences are Digital desktop
applications that have been integrated into CDE. See Section
5.3.1 and Section 5.3.6 respectively for more information.
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You cannot migrate to a new user interface without expecting
changes. The Common Desktop Environment (CDE) offers you
tools and methods to customize your environment that differ from
those used in the DECwindows Motif environment. This chapter
briefly describes how to customize your session.

8.1 Customizing your Startup Environment
In the DECwindows Motif environment, the Session Manager
offers an Application menu and Customize menu. The
Application menu lists default applications available to you. By
using the Customize menu, you can add or remove applications
from the Applications menu. You can also specify that certain
applications start automatically at each login session by selecting
the Autostart menu item from the Customize menu.

Using CDE, you can add frequently used applications to the Front
Panel and subpanels. See Section 7.2.1 for information on adding
applications to the Front Panel and subpanels. The applications
that are started automatically at startup are determined by the
options you set when using the Style Manager Startup control.

When you click on the Style Manager Startup control, a dialog
box appears. You have the option of returning to your current
session, home session, or a display-specific session when you log
in next:

• Resuming the current session restores your session to the state
present at logout.

• Resuming a home session returns to the same state each time.
That is, any settings you specified during your current session
are ignored.

• Starting a display-specific session is accomplished by copying
the file $HOME/.dt/sessions to the file
$HOME/.dt/display where display is a real unqualified
hostname such as host:0. Using host.site.com:0 is
not valid.



See the Common Desktop Environment: User’s Guide for
information on adding applications and setting a login session.
See the Common Desktop Environment: Advanced User’s and
System Administrator’s Guide for information on setting a
display-specific session.

8.2 Changing Session Manager Settings
From the DECwindows Motif Session Manager Customize menu,
you can use the Options menu to do the following:

• Start the Session Manager as a window or icon

• Turn on or off logout confirmation

• Change the message displayed in the Pause (Lock) screen

When using CDE, the Front Panel is always displayed unless you
start a Failsafe session, Command-Line Login session, or
DECwindows Motif session. To turn the Front Panel into an icon
after logging into the system, use the window or menu controls.

To turn Logout Confirmation on or off, use the Style Manager
Startup control.

You cannot change the the Lock (Pause) screen message as was
possible when using DECwindows Motif.

8.3 Customizing Window Patterns and Colors
From the DECwindows Motif Session Manager Customize menu,
you can use the Windows... menu item to do the following:

• Choose a different window manager

• Specify a screen saver

• Change background patterns

• Select solid foreground and background

• Choose window foreground, background, highlight and border
colors

Changing these options when using CDE differs. The following
sections discuss how to change the window manager, specify a
screen saver and lock background, select a background pattern,
and how to change colors.
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8.3.1 Changing the Window Manager
When you start a CDE session, the default window manager,
/usr/dt/bin/dtwm is started. Unlike the DECwindows Motif
environment, specifying an alternate window manager is an
advanced feature. You edit resource files to change the Window
Manager in CDE. See the Common Desktop Environment:
Advanced User’s and System Administrator’s Guide for further
information.

8.3.2 Specifying a Screen Saver and Lock Screen Background
A screen saver extends the life of your monitor by blanking the
screen after a specified amount of time. By default, the monitor
blanks the display after 10 minutes. Moving the mouse causes the
display to resume. A screen lock background is displayed when
you pause a session from the CDE Front Panel.

You can customize what is displayed by using the Style Manager
Screen control.

8.3.3 Selecting a Background Pattern
In CDE, you can specify a background pattern for each of your
workspaces using the Style Manager Backdrop control. The
Backdrop control opens a dialog box, which offers a scrollable
lists of background selections. You can also display the root
window by selecting No Backdrop from the list of options.

8.3.4 Changing Screen and Window Colors
When using the CDE Style Manager, colors are set by using the
Style Manager Color control. The Color control sets screen,
window, workspace, and Front Panel colors according to your
display type. Depending on your display type, you may have 2, 4,
or 8 color buttons that you can use to control the color of
windows, window borders, workspaces, text and list areas, and
Front Panel background. See the Common Desktop Environment:
User’s Guide for information on color controls and selecting color
palettes.

8.4 Changing Your Security Settings
To change your security settings, use the Host Manager
application or the xhost command. The Host Manager displays
icons for all hosts known to the local system and for those hosts
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that you specify. By using the Host Manager, you can set the
DISPLAY environment variable and run applications from a
remote system.

To start the Host Manager from the Application Manager:

1. Double click on System_Admin.

2. Double click on System_Management_Utilities.

3. Double click on the Host Manager application.

See the Host Manager online help for more information. To view
the online help, click on the Help menu from within the
application.

To use the xhost command, see the xhost reference page.

8.5 Customizing the Keyboard Settings
When using CDE, keyboard settings can be changed by using the
Style Manager controls and the Keyboard Options application.
The following sections discuss these methods.

8.5.1 Using Style Manager to Adjust Keyboard Settings
By using the Style Manager controls, the following keyboard
settings can be adjusted:

• Beep (Bell) Volume

Sets the volume, tone and duration of the warning beep (bell)
or turns the beep off. The warning beep notifies you of system
messages, or warns you when you type incorrect key
combinations in applications such as the vi text editor.

• Keyclick Volume and Auto Repeat

Sets the click volume of keys as you type or turns off the click
volume. You can also set whether or not a key repeats for as
long as it is pressed.

To adjust the click volumes of keys and to turn auto repeat on
or off, use the Style Manager Keyboard control. A dialog box
appears that you can use to change the keyclick volume and
auto repeat of keys.
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8.5.2 Using Keyboard Options to Adjust Keyboard Settings
The Keyboards Options application has been migrated and
integrated into the CDE interface. It offers further options that
you can use to control keyboard settings. Use this application to
set the following:

• Keyboard Type

• Language Type

• Lock Key State

By using the Keyboard Options application, you can also start the
Keycaps application and save and load settings for future sessions.
For more information on the Keyboard Options and Keycaps
applications, see Chapter 5.

8.5.3 Changing PC-Style Keyboards
Several Digital workstations come with Personal Computer (PC)
style keyboards. Currently, these keyboards have one of the
following model numbers, although more models may be produced
in the future:

• PCXAL

• LK443

• LK444

Other Digital workstations come with keyboards such as the
LK201 or LK401.

The two styles of keyboards differ both in the functions assigned
to certain keys and in the number of function keys. For example,
the PC-style keyboards have only 12 function keys (F1 through
F12); the LK201/LK401 keyboards have 20 function keys (F1
through F14, Help, Do, and F17 through F20).

Digital UNIX provides a script that automatically performs
mappings to allow you to switch keyboard styles. This script,
/usr/examples/pc_to_lk_keys.sh, uses the xmodmap
utility to edit the keyboard modifier map and keysym table. (For
details about the utility, see the xmodmap reference page.)

If you have a PC-style keyboard, you can run the script to map
most of the keys on the two keypads to the right of the main
keyboard, as well as a few keys in the top function key row, to the
corresponding keys on the LK201/LK401 keyboards. For example,
by running the script, you change the function of the keypad Insert
key on the PC-style keyboard to perform the keypad Find function
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from the LK201/LK401 keyboards.

Similarly, if you have an LK201/LK401 style keyboard, you can
run the same script, this time with the -u flag, to map the keypad
keys to the corresponding PC-style keys.

A copy of the script is located in the following file on your Digital
UNIX system:

/usr/examples/pc_to_lk_keys.sh

To run the script, at the system prompt enter the name of the file
as if you were entering a command. The first command line in the
following example changes PC-style keys to LK201/LK401 keys.
The second command line changes LK201/LK401 keys to PC-
style keys.
% /usr/examples/pc_to_lk_keys.sh
% /usr/examples/pc_to_lk_keys.sh -u

To have the script run automatically each time you log on to your
workstation, use an editor to create or modify the .xsession
file in your home directory to read as follows :
#!/bin/sh
/usr/examples/pc_to_lk_keys.sh
dxsession

This change PC-style keys to LK201/LK401 keys. The same
.xsession file, but with -u flag added to the end of the second
line, changes LK201/LK401 keys to PC-style keys.

Now, whenever you log in, your keyboard is set automatically to
the different keyboard style.

Table 8-1 shows the keys on the LK201/LK401 keyboard and their
corresponding equivalents on the Digital PC-style keyboard.

Table 8-1:   LK201/LK401 Key Functions and Their PC-
Style Equivalents

22222222222222222222222222222222222222222222222222222
Key on the
LK201/LK401
Keyboards

Equivalent Key or Function
on a PC-Style Keyboard

22222222222222222222222222222222222222222222222222222
Help Print Screen

Do/Menu Scroll Lock

Insert Home

8–6 Customizing your Environment



Table 8-1:   (continued)
22222222222222222222222222222222222222222222222222222
Key on the
LK201/LK401
Keyboards

Equivalent Key or Function
on a PC-Style Keyboard

22222222222222222222222222222222222222222222222222222
Find Insert

Remove Page Up

Next Page Down

Select Delete

Prev End

Keypad 0 Ins, Keypad 0

Keypad 1 End, Keypad 1

Keypad 2 down arrow, Keypad 2

Keypad 3 PgDn, Keypad 3

Keypad 4 left arrow, Keypad 4

Keypad 5 Keypad 5

Keypad 6 right arrow, Keypad 6

Keypad 7 home, Keypad 7

Keypad 8 up arrow, Keypad 8

Keypad 9 PgUp, Keypad 9

Keypad . (period) Keypad Del

Keypad - Keypad + (addition)

Keypad , no equivalent PC-style keypad key

Keypad Enter Keypad Enter

PF1 Num Lock

PF2 Keypad / (division)

PF3 Keypad * (multiplication)

PF4 Keypad - (subtraction)22222222222222222222222222222222222222222222222222222

Note

The Digital PC-style keyboard has a key labeled ← in
the position where the key marked 331

33
is located on

the LK201/LK401 keyboard. On both styles of
keyboard, this key deletes the character to the left of
the cursor when pressed. On the PC-style keyboard,
you can use the Delete key on the near keypad to
delete the character that the block cursor is on or the
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character to the left of the line cursor.

In keyboard mappings, the ← and 331
33

keys perform
the backspace function. The Delete key on the PC-
style keyboards performs the delete function.

8.6 Specifying a Session Language
By using CDE, you can specify a language type each time you log
into the system. You cannot change the language during the
session.

To set the session language from the login screen, click on the
Options menu, then click on the Language menu item and select a
language group. You can select from a list of languages that have
been installed on your system.

8.7 Customizing Mouse and Pointer Behavior
When using CDE, mouse and pointer behavior is adjusted by
using the Style Manager Mouse control. CDE offers some
adjustments not available in the DECwindows Motif environment;
however when using CDE, you cannot adjust the color or shape of
the pointer.

Use the Mouse control to adjust the following:

• Handedness (Button Arrangement)

Specifies how mouse buttons are to be interpreted. By default,
mouse buttons are arranged for use by righthanded person.
That is, mouse button 1 is on the left and mouse button 3 is on
the right. You can specify that mouse button 1 be the leftmost
button and mouse button 3 be the rightmost button for a
lefthanded person.

• Button 2

Specifies the behavior of mouse button 2. Mouse button 2 can
be set to Transfer or Adjust mode. When using the Transfer
setting, mouse button 2 is used to drag and drop list or text
items (if supported by the application).

When using the Adjust setting, mouse button 2 extends lists
selections in a multiple-select list or extends text selection
fields; list items are dragged and dropped by using mouse
button 1.
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• Pointer Acceleration

Provides a slider that you can use to vary how fast the pointer
moves across the screen. For example, a setting of 2 causes
the pointer to move twice as fast as the mouse moves.

• Mouse Double Click Timeout

Specifies how the system interprets two successive clicks of
the mouse. That is, it sets the time in which you must click a
mouse twice to signal a double click action. For example,
double clicking on certain icons starts an application.

• Mouse and Pointer Threshold

Specifies the minimum number of pixels you must move the
mouse before the pointer moves at the specified accelerated
speed.

8.8 Saving and Restoring Settings
Any changes that you make during a session can be saved. When
you change options or settings using the Style Manager, each
control provides a dialog box that you can use to OK or Apply
changes. Using the CDE Style Manager Startup control gives you
the opportunity to specify whether these are the settings you return
to in your next session.

The CDE Style Manager Startup control specifies whether you
return to your current session, home session, or a display-specific
session.

8.9 Modifying Resource Files
The Common Desktop Environment: Advanced User’s and System
Administrator’s Guide describes the resource files you can modify
to change your environment. This section briefly highlights those
files you edited previously under DECwindows Motif and explains
whether or not they remain applicable:

• The .xsession file is still valid in the new environment.

• The .Xdefaults file can still be used; however, automatic
startup of applications is not valid.

• The .mwmrc file has been replaced by the
$HOME/.dt/dtwmrc file.

• The .X11start file has been replaced by the
$HOME/.dt/session/sessionetc file.
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Under DECwindows Motif, the system administrator often edited
files in /usr/lib/X11/xdm. Equivalents in CDE can be found
in /usr/dt/config. These files include Xaccess,
Xservers, Xsession and Xsetup/Xsetup -0.
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9Using Internationalization Features3333333333333333333333
Migrating to the Common Desktop Environment (CDE) affects
those who used internationalization features in the DECwindows
Motif environment. Differences exist in the following:

• Selecting language types

• Specifying a keyboard type, loading keymaps, and selecting
input methods

• Using the terminal emulator

• Using mail

The following sections explain these differences and provide
information on how to accomplish the same tasks using CDE.

9.1 Selecting a Language Type
In the DECwindows Motif environment, you change the language
type at any time using the Option menu. When using the CDE
interface, you can select a language at the start of a session or set
resources in CDE’s Xconfig file. The language that you select
cannot be modified during the session.

Information on setting a language from the login screen is
documented in Section 2.3.1.

To set the default session by editing the Xconfig resource file:

1. Create the directory /etc/dt/config if it does not exist.
You must have root privileges to create this directory.

2. Copy the file /usr/dt/config/Xconfig to the directory
you created in step 1.



3. Edit the file /etc/dt/config/Xconfig and add the
language you want to use as your default. For example, if you
want to use Japanese, add the following line:
defaultLanguage: ja_JP.eucJP

If you do not want to use this language during each session, you
can override it by selecting another from the CDE Login Screen
Options menu.

No matter which method you use to select a language, each
application you start after logging into the system is displayed in
the language selected.

9.2 Specifying a Keyboard Type, Keyboard Attributes
and Input Methods

In the DECwindows Motif environment, you can select a keyboard
type, keyboard characteristics, and an input method from the
Session Manager. Your choices set parameters in the
.Xdefaults file. When using CDE, you must use the Keycaps,
Keyboard Options, and Input Methods applications to change these
characteristics.

The Keyboard Options application is used to select a localized
keymap and to set the lock key state. From this application, you
can also start the Keycaps application, which is used to change
keycaps mappings. See Section 5.3.4 for information on using
this application.

The Keycaps application is used to select a keyboard type,
simulate key events, and to display and edit keyboard mappings.
To use the Keycaps application, see Section 5.3.5.

The Input Methods application is used to change how keystroke
characters are interpreted by the system. For example, Asian
(multibyte) characters such as Japanese Kanji or Chinese Hanzi
characters can be entered from the keyboard using this application.
See Section 5.3.3 for more information on this application.

Note

For Asian Languages, the CDE Session Manager
automatically starts the appropriate input method
server when you log into the system. To disable this
feature, edit your .dtprofile file and set
DTSTARTIMS to False.
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9.3 Using the Terminal Emulator
The default terminal emulator in the CDE interface is dtterm.
The dtterm terminal emulator does not have the following
features:

• Bidirectional support (needed for Hebrew language support)

• Zero-width character support (needed for Thai language
support)

• Ruled-line support (needed for Japanese language support).

Because these features are not supported, using the DECwindows
Motif terminal emulator, dxterm, is recommended where such
support is needed. You can access dxterm from the Application
Manager. In certain locales, dxterm is available from the Text
Editor Personal Applications subpanel. You can also start the
dxterm terminal emulator from a dtterm terminal emulator
window or add it to the Front Panel or a subpanel as described in
Section 7.2.1.

See the Common Desktop Environment: User’s Guide for
instructions on using the dxterm terminal emulator.

9.4 Using Mail
When using the DECwindows Motif mail application, dxmail,
codeset conversion support is turned on by specifying a mail
interchange codeset in the /usr/lib/mh-codesets file.
When using the CDE mail application, dtmail, you do not have
to turn on codeset conversion support. It is turned on
automatically through the /usr/dt/config/svc/OSF1.lcx
configuration file, which contains the needed information.
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10Migrating Mail and Calendar3333333333333333333333
Many people have mail folders and calendar databases that they
want to continue to use in their new environment. Changing to a
new application often means losing this information. To ease the
complexity of migrating, you can use the tools described in this
chapter to convert your existing dxmail and dxcalendar
folders and databases into a format that is understood by the CDE
mail and calendar applications.

The Common Desktop Environment: User’s Guide provides details
on using the CDE Mail and Calendar applications. See Appendix
A for information on the differences between the MH/dxmail and
dtmail mail handlers.

10.1 Converting Mail Formats
The CDE mail application is completely integrated with the
environment and thus offers more flexibility than continuing to use
the dxmail application. For example, files can be dragged from
other CDE applications and dropped onto the mail application for
further action.

The CDE mail application also supports Multimedia Internet
Messages Extension (MIME). Support for MIME lets you send
and receive mail messages in formats other than ASCII text. For
example, you can send and receive messages that are in video
format.

Before you convert your mail formats to a format that can be read
by the CDE mail application, you should understand how mail is
stored by both applications. You can then convert your mail from
the dxmail format to the dtmail format by using the mailcv
utility or the CDE File Manager.

10.1.1 Understanding How Mail Is Stored
The dxmail and dtmail applications store information
differently. For this reason, you must convert your dxmail
folders to a format that can be read by the dtmail application.



10.1.1.1 Storing Mail Using MH/DXMail

To store mail, the MH/dxmail application creates a mail
hierarchy with a top level directory. The location of this directory
is defined in your $HOME/.mh-profile. This profile not only
specifies the location of your top level directory, it also includes
other information about the setup of your mail. Usually, the path
for the top level directory is set to $HOME/Mail. If you
changed this path, you can verify its location by using the
mhpath command with the + flag. You need to know the
location of your top level directory to convert mail folders.

Note

To use the mhpath command, the MH subsets must
be installed on your system.

Under your top level directory Mail, you may have several other
directories (folders) or files. Messages are stored in folders
numerically and in sequential order. Each message corresponds to
an individual file as follows:

Mail

/inbox /drafts /meetings /personal

1,2,3 1,2 /group /unit 1,2,3 /gardening

1,2,3 1,2,3 1,2,3

In the previous example, there are four folders directly under the
top level directory Mail. Individual messages are stored
numerically. For example, under the folder Inbox, there are
three files that contain individual mail messages. They are
numbered 1, 2, and 3. Some directories have subdirectories
such as meetings, which includes subdirectories for group
and unit. Mail messages are further grouped under these
directories numerically.

10.1.1.2 Storing Mail Using the CDE Mail

By using the CDE Mail application, there is no set structure to
how messages are stored. That is, you can create mail folders in
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any directory that you have access to, and you can store more than
one message in a mail folder. The dtmail application uses the
UNIX From format to store messages. Thus, mail messages
stored in the same mail folder are concatenated and each message
is separated by a UNIX From header. Mail utilities such as
mailx use this format and can also read these messages.
Following is a sample mail hierarchy that can be created by using
the dtmail application. In this example, messages are stored
into mail folders that have an .mbe extension.

MailBox

inbox.mbe drafts.mbe /meetings /status

/group /unit jan.mbe feb.mbe

wkly.mbe mthly.mbe

In the previous example, the top level directory, MailBox, is
displayed. Under this top level, there are both directories and mail
folders. The mail folders can contain one or more mail messages.
A mail directory can contain both mail folders and other
subdirectories. Messages are concatenated in the order they are
saved.

10.1.2 Converting Mail Using the Mail Conversion Utility
The mailcv utility is a command line interface that you can use
to convert an entire directory or an individual folder. There are
several flags available that you can use to control how mail is
converted. In addition, the mailcv utility can be used to detect
errors that may have occurred when you stored messages.

By default, all messages created by the dxmail application are
converted, including any corrupt messages. See Section 10.1.2.4
for information on corrupt messages.

10.1.2.1 Converting an Entire Mail Directory

To convert an entire mail directory (folder) by using the mailcv
utility:

1. Change to your top level mail directory. By default, this is
$HOME/Mail.
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2. Type the mailcv command with the -A flag to specify that
you want to convert the entire directory and subdirectories.
You must specify the current directory name and the name of
the new directory that is to be created as follows:
% mailcv -A $HOME/Mail $HOME/NewMail

This example creates a new top level directory called
NewMail. It then creates the subdirectories that correspond
to the dxmail folder structure and all mail messages are
converted.

10.1.2.2 Converting an Individual Folder

To convert an individual folder using the mailcv utility:

1. Change to the directory that contains the MH folder and
message files you want to convert.

2. Type the mailcv command with the -f flag to specify that
you want to convert a folder to the UNIX From format. You
must specify the current name of the folder followed by a new
name for the folder as follows:
% mailcv -f inbox Inbox

This example creates a new folder called Inbox. If a new
folder name is not specified, a new folder is created using the
name of the current folder followed by the extension .mbe.

If the folder you are converting contains subfolders, the
subfolders are not converted. Use the steps described to
convert each folder or subfolder.

10.1.2.3 Using Flags to Control Mail Conversion

The mailcv command offers several command flags that you can
use when converting mail folders and directories. The flags are
described in detail in the mailcv reference page.

Using the mailcv command, you can specify flags to:

• Stops the conversion of a folder if a corrupted message is
found. A message is corrupted if it is missing one of the
primary RFC 822 headers that include: From, Date, and
Reply-To. An error message is displayed indicating the
number and folder name of the corrupted message and no
further messages are copied into the folder.
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• Delete MH/dxmail folders and messages after they have been
converted. However, if the folder contains other messages not
in MH format, the folder is not deleted.

• Skip over any corrupt messages and continue with the
conversion of messages that have the correct mail headers.

• Write to standard output the folder and message number that is
being converted.

10.1.2.4 Converting Corrupt Mail Messages

If you do not use the mailcv utility with the flags that handle
corrupted messages, the messages headers are converted as
follows:

• From field is set to USER@UNKNOWN

• Date field is set to Mon, 01 Jan 1976 09:00:00 -000

10.1.3 Converting Mail Using the File Manager
The CDE File Manager provides a graphical display of directories
and files. Using the CDE File Manager, you can convert the
whole mail hierarchy or you can choose to convert a single folder.

Although the CDE File Manager calls the mailcv utility to
complete the conversion, it does not provide you the option of
specifying flags to detect mail header errors. To detect errors
before converting your mail directories, use the mailcv utility’s
command line interface. If you do not address corrupt files, the
corrupt files are converted as described in Section 10.1.2.4

10.1.3.1 Converting the Entire Mail Hierarchy

To convert the entire mail hierarchy from the CDE File Manager:

1. Start the CDE File Manager.

2. Change to the directory that contains the MH folders to be
converted.

3. Point to the MH mail folder icon, then click on mouse button
3 to display the Action menu.

4. Select the Mail Convert menu item from the Action menu.

A dialog box appears. You must enter a new pathname for the
new directory hierarchy. Click OK after entering the new
directory name.
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After you select a new location for the directory hierarchy, the
mailcv utility begins the conversion. Depending on the size of
the mail hierarchy, the conversion may take some time. When it
is complete, your mail is accessible from the CDE mail
application.

10.1.3.2 Converting an Individual Folder

To convert a single folder from the CDE File Manager:

1. Start the CDE File Manager.

2. Set your path to the MH pathname where the top level mail
directory is located. Use the mhpath command with the +
flag if you are unsure of the location.

Note

To use the mhpath command, the MH subsets
must be installed on your system.

After setting your path, the CDE File Manager displays the
Mail directories (folders). Each is represented by an icon.

3. Change to the folder that you want to convert.

4. Select the Mail Convert menu item from the Action menu.

A dialog box appears. You must enter a new folder name for
the new folder. Click OK after entering the new name.

After you select a new location for the folder, the mailcv utility
begins the conversion. Subfolders in the folder you are converting
are not converted. Depending on the size of the folder, the
conversion may take some time. When it is complete, your mail
is accessible from the CDE mail application.

10.2 Converting Calendar Databases
The dxcaltodtcm application converts a calendar database file
that has been created with the dxcalendar application to a
format that can be used by the CDE calendar application, dtcm.
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To convert a dxcalendar database:

1. Invoke the dxcalendar command with the -migrate
option.
$ dxcalendar -migrate

A text file called $HOME/dwc_db_migration.data is
created. This file contains your calendar entries.

2. Run the CDE Calendar application, dtcm, and set the hour
display to 12.

3. Invoke the dxcaltodtcm application to read the created text
file and add the entries to the CDE calendar database.

The dxcalendar command is in /usr/bin/X11 and the
dxcaltodtcm command is in /usr/dt/bin.

Note

Because some features of the DECwindows Calendar
are not available in the CDE Calendar, some loss of
information is possible in converting a calendar
database. See the dxcaltodtcm reference page for
a list of restrictions.
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ADifferences in Mail Handlers3333333333333333333333
There are differences in how the CDE mail application and the
DECwindows Motif mail manage mail operations. This appendix
discusses:

• Features present in the CDE mail application, but not present
in the DECwindows Motif mail application

• Absence of MH features in the CDE mail application

• Differences between MH/DXmail and the CDE mail applcation

A.1 Features Available in the CDE Mail Application
This section highlights some of the features available in the CDE
mail applcation that are not available in the MH/DXmail
application:

• Provides minimal compliance for the Multipurpose Internet
Messages Extension (MIME) standard.

See the RFC 1521 for a description of MIME.

• Turns vacation notification on or off from within the dtmail
application.

• Provides a Spell Checker to check spelling when composing
messages.

• Supports search and substition of text when composing a
message.

• Supports use of templates (composed text) that you can include
in mail messages.

• Offers a Comprehensive Options dialog box that you can use
to do the following:

– Set aliases

– Specify predefined headers during compose

– Specify the removal of headers during read operations

– Set message numbers



– Indent an included message during a reply operation

– Set an auto log of send messages

– Specify a top level directory for mailfolders, and others
files

A.2 Features not Available in the CDE Mail Applications
The following list highlights some differences between the
DECwindows Motif mail and CDE mail applications:

• User’s view of folders

The dxmail application provides a window that lists all
available mailboxes (folders) for each user. The dtmail
application does not provide this feature. To view mail folders
under CDE, you must use the File Manager. Thus, if you
maintain your mail in one directory, you can use the features
of the File Manager with dtmail to open folders and so
forth, or manage your mail directories. See the CDE User’s
Guide for information on the File Manager and using
datatypes.

• Post Office Protocol (POP)

POP consists of two components: daemon and the client. The
daemon is supported by CDE Mail if the subset is installed,
but the client is not.

• Personal Editors

The dtmail application does not support the ability to
specify an editor of your choice when composing mail.

• Modifying read messages

The dtmail application does not provide the ability to
modify a message when in read mode. To modify a message,
forward the message to yourself. Then, in the Compose
window, edit, then send the message.

• Signatures

The dtmail application does not provide the ability to
specify a Signature. The GECOS field specified in the
/etc/passwd file is used instead.
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A.3 Differences Between MH and the CDE Mail
Applications

Unlike the dtmail application, the dxmail application uses the
Rand Corporation Mail Handler (MH) to process mail. The
following table lists the availability of MH attributes in the CDE
mail application.

Table A-1:   Differences in Mail Handlers
22222222222222222222222222222222222222222222222222222222222
MH Command Use of Command Available

in CDE Mail22222222222222222222222222222222222222222222222222222222222
alex NoExtracts addresses from

message headers

ali YesLists mail aliases

anno NoAnnotates messages

ap YesParses addresses RFC
822-style

burst NoExplodes and digests into
messages

comp YesComposes a new message

conflict NoSearches for
alias/password conflicts

dist YesRedistributes a message to
additional addresses

dp YesParses dates RFC 822-
style

folder YesSets or lists current
folder/message

forw YesForwards message

inc Yes (reads new mail)Incorporates new mail

install-mh NoInitializes the MH
environment

mark NoMarks messages

mhl NoProduces formated listings
of MH messages

mhmail YesSends or reads mail

mhpath NoPrints full pathnames of
MH messages and folders
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Table A-1:   (continued)
22222222222222222222222222222222222222222222222222222222222
MH Command Use of Command Available

in CDE Mail22222222222222222222222222222222222222222222222222222222222
msgchk YesChecks for messages

msh Not applicableStarts MH shell

next YesShows the next message

packf Not applicableCompresses a folder into
a single file

pick Partially availableSelects messages by
content

post YesDelivers a message

prev YesShows the previous
message

prompter NoPrompting editor front
end

rcvstore Not applicableIncorporates new mail
asynchronously

refile YesFiles messages in different
folder

repl YesReplies to a message

rmf NoRemoves a folder

rmm YesRemoves messages

scan YesProduces a scan listing
that has one line per
message

send YesSends a message

slocala YesReceives mail hooks

show YesShows (lists) messages

sortm YesSorts messages

whatnow NoPrompting front-end for
send

whom NoReports who receives a
message when sent22222222222222222222222222222222222222222222222222222222222

a. Available only if the MH subset is installed.
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organizing in groups, 4–5 to 4–6

recommended for use, 7–6

running across network, 5–2

running from a remote system, 5–3

running from Application Manager, 4–6

starting automatically, 7–2

starting from Application Manager, 5–1

starting from File Manager, 7–5

starting from the terminal emulator, 5–1

using drag and drop, 7–6

ascii text files

comparing, 5–5 to 5–7

B
backdrops

using, 4–6

background patterns, 4–7

Backspace function key, 8–8

beep volume

setting, 4–7



Bourne shell

setting DISPLAY environment variable, 5–3

built-in applications groups, 4–5

busy indicator, 3–2

busy light, 3–2

C
C shell

setting DISPLAY environment variable, 5–3

calendar, 3–1

converting to CDE format, 10–6 to 10–7

Check buttons

using, 2–6

click

using mouse, 2–2

clock, 3–1

Color

changing in screen, 4–6

command-line session, 2–9

starting, 7–1

confirmation

turn on and off at logout, 4–8

conversion

of dxcalendar databases, 10–6

copying files and directories, 4–3

current session, 4–8

D
DECwindows Motif

migrating to CDE applications, 7–6

DECwindows Motif session

starting, 2–8

Default Printer control, 3–5

Delete function key, 8–8

deleting files and directories, 4–2

desktop applications

integrated into CDE, 5–4 to 5–19

desktop session

managing, 4–1 to 4–8

selecting a session type, 2–8 to 2–9

dialog boxes

opening, 2–6

using, 2–6 to 2–7

using list boxes, 2–7

using push buttons, 2–7

using Radio and Check buttons, 2–6

using sliders and scales, 2–7

Differences

changing display attributes, 5–6 to 5–7

comparing files, 5–5 to 5–7

displaying files, 5–6

exiting from application, 5–5

moving between differences, 5–7

selecting files, 5–5

starting, 5–5

directories

changing, 4–2

changing permissions, 4–3

copying, 4–3

creating, 4–2

deleting, 4–2

displaying contents of, 4–4

displaying when hidden, 4–4

managing, 4–1 to 4–5

moving to workspace, 4–3

printing from File Manager, 4–4

renaming, 4–3

searching for, 4–2

viewing, 4–2
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display, 5–3

DISPLAY environment variable

setting from different shells, 5–3

display-specific session, 8–1

documents

viewing image files, 5–7 to 5–8

double click

using mouse, 2–2

drag and drop

using mouse, 2–2

dtmail

storing, 10–2 to 10–3

dtsession, 6–2

dtwmrc file, 8–9

dxcalendar

converting to CDE format, 10–6 to 10–7,

10–6

dxcaltodtcm command, 10–6

dxmail

converting to CDE mail format, 10–1 to

10–6

storing, 10–2

dxsession, 6–2

starting, 7–1

E
ending a session, 2–10, 4–8

environment

customizing using Style Manager, 4–6 to 4–8

exiting a session, 3–2

F
failsafe session, 2–9

starting, 7–1

File Manager, 1–3, 3–1

changing directories, 4–2

changing permissions, 4–3

converting dxmail folders, 10–5 to 10–6

copying files and directories, 4–3

creating new directories, 4–2

creating new files, 4–2

deleting files and directories, 4–2

displaying files and directories, 4–4

displaying hidden files and directories, 4–4

dragging an application from, 7–6

exiting, 4–3

managing directories and files, 4–1 to 4–5

moving files and directories, 4–3

moving objects to workspace, 4–3

opening a new window, 4–4

opening terminal emulator window, 4–3

printing files and directories, 4–4

renaming files and directories, 4–3

running applications from, 7–5

saving settings, 4–4

searching for files and directories, 4–2

specifying formats, 4–4

using File menu, 4–2

viewing directories, 4–2

files

changing permissions, 4–3

comparing, 5–5 to 5–7

copying, 4–3

creating, 4–2

deleting, 4–2

displaying contents of, 4–4

displaying when hidden, 4–4

managing in directories, 4–1 to 4–5

moving, 4–3

moving to workspace, 4–3
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files (cont.)

printing from File Manager, 4–4

renaming, 4–3

searching for, 4–2

viewing different formats, 5–7 to 5–8

Front Panel

accessing Application Manager, 3–2

accessing calendar, 3–1

accessing clock, 3–1

accessing File Manager, 3–1

accessing Help Manager, 3–2

accessing lock, 3–2

accessing mail, 3–2

accessing Print Manager, 3–2

accessing Style Manager, 3–2

accessing Text Editor, 3–2

accessing Trash Can, 3–2

accessing workspaces, 3–2

adding applications, 7–3, 7–4

busy light, 3–2

controls, 3–1 to 3–3

customizing, 7–4

exiting a session, 3–2

locking a session, 3–2

pausing a session, 3–2

removing customizations, 7–4

replacing a control, 7–4

tools, 3–1 to 3–3

using, 3–1 to 3–7

H
Help Manager, 1–7

Help subpanel, 3–5

hidden directories

displaying, 4–4

hidden files

displaying, 4–4

home session, 4–8, 8–1

I
image files

viewing, 5–7 to 5–8

Image Viewer

viewing files formats, 5–7 to 5–8

Input Methods

changing keystroke characters, 5–8 to 5–9

changing servers, 5–9

specifying preediting modes, 5–8 to 5–9

specifying style preferences, 5–8 to 5–9

Install Icon

using to add tools, 3–3

K
key events

simulating, 5–12

key mappings

modifying, 5–12 to 5–13

key settings

modifying, 5–12 to 5–13

keyboard

changing keystroke characters, 5–8 to 5–9

customizing settings, 5–9 to 5–11

displaying graphical picture of, 5–11

listing alternate types, 5–13

LK201/LK401, 8–5

LK-style with PCXAL, 8–5

modifying key settings, 5–12 to 5–13

navigating with, 2–2

PC-style with LK201/LK401, 8–5

redefining mappings, 5–11 to 5–13
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keyboard (cont.)

resetting default, 5–13

saving attribute settings, 5–10 to 5–11

saving attributes, 5–13

simulating key events, 5–12

specifying a type, 5–9 to 5–10

specifying attributes, 5–9 to 5–10

specifying editing modes, 5–8 to 5–9

specifying style preferences, 5–8 to 5–9

Keyboard Options

saving settings, 5–10 to 5–11

specifying attributes, 5–9 to 5–10

using to change settings, 5–9 to 5–11

keyboard types

selecting, 5–9 to 5–10

specifying a language for, 5–9 to 5–10

Keycaps

customizing keyboard, 5–11 to 5–13

displaying graphical picture of, 5–11

duplicating keys, 5–12 to 5–13

editing keys, 5–12 to 5–13

exchanging keys, 5–12 to 5–13

listing alternate keyboards, 5–13

modifying key settings, 5–12 to 5–13

resetting default, 5–12 to 5–13

saving attributes, 5–13

simulating key events, 5–12

keystroke characters

changing, 5–8

Korn shell

setting DISPLAY environment variable, 5–3

L
language types

specifying for keyboard, 5–9 to 5–10

languages

changing input methods, 5–8 to 5–9

specifying at login, 2–8

list boxes

using, 2–7

lock mechanism, 3–2

locking a session, 2–9, 3–2

logging in, 2–7

resetting login screen, 2–9

specifying a language, 2–8

specifying a session, 2–8 to 2–9

specifying system behavior, 4–8

logging out

specifying system behavior, 4–8

turning on or off confirmation, 4–8

Login Manager, 2–7

login screen

displaying, 2–7

resetting, 2–9

selecting options, 1–1

specifying a command-line session, 2–9

specifying a DECwindows Motif session,

2–8

specifying a failsafe session, 2–9

specifying a language, 2–8

specifying a regular desktop session, 2–8

specifying a session type, 2–8 to 2–9

logout confirmation

turning on or off, 8–2
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M
mail, 3–2

converting to CDE format, 10–1 to 10–6

differences between dtmail and dxmail, A–1

to A–4

storing in dtmail format, 10–2 to 10–3

storing in MH/DXmail format, 10–2

mail conversion utility, 10–3 to 10–5

mailcv utility, 10–3 to 10–5

Mailer

See mail

managing directories, 4–1 to 4–5

managing files, 4–1 to 4–5

menu bar, 2–3

menus

opening dialog boxes, 2–6

using, 2–5 to 2–6

using Option menu, 2–5

using pop-up, 2–5

using pulldown, 2–5

using submenus, 2–6

migration

from DECwindows Motif to CDE, 7–1

mouse

changing button control, 4–7

changing click action, 4–7

copying and pasting text in windows, 2–4

navigating with, 2–1 to 2–2

performing click action, 2–2

performing double click action, 2–2

performing drag and drop, 2–2

using to activate windows, 2–4

using to move windows, 2–4

mouse button 1, 2–1

mouse button 2, 2–2

mouse button 3, 2–2

multiple windows

managing, 2–4 to 2–7

N
navigating

using keyboard, 2–2

using mouse, 2–1 to 2–2

O
On Item help, 1–7

Option menu

in windows, 2–5

P
palettes

selecting colors, 4–6

pausing a session, 2–9, 3–2

PC-style keyboard, 8–5

permissions

changing for files and directories, 4–3

Personal Application subpanel, 3–4

Personal Printer subpanel, 3–4 to 3–5

pop-up menus, 2–5

Print Manager, 3–2

Print Screen

exiting application, 5–16

saving settings, 5–16 to 5–17

specifying printer options, 5–16

starting, 5–13

using, 5–13 to 5–17

using options, 5–14 to 5–17

pulldown menus, 2–5

push buttons

using, 2–7
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R
Radio buttons

using, 2–6

regular desktop session, 2–8

remote applications

running on local system, 5–2 to 5–3

resizing windows, 2–3

S
scales

using, 2–7

screen captures

obtaining, 5–13 to 5–17

printing, 5–16

specifying options, 5–14 to 5–17

specifying output format, 5–16 to 5–17

screen saver

using, 4–8

screens

capturing picture of, 5–13 to 5–17

changing appearance, 4–6

changing color of, 4–6

changing workspaces, 3–6, 7–3

specifying fonts, 4–6

scroll bars, 2–3

session

choosing a type, 7–1

customizing, 8–1 to 8–10

differences between DECwindows Motif and

CDE, 7–1

ending, 2–10

ending with applications running, 7–2

pausing, 2–9

resuming, 8–1

starting, 2–7

session manager

changing settings, 8–2

starting, 6–2

sessionetc file, 8–9

sliders

using, 2–7

snapshot

taking picture of screen, 5–13 to 5–17

starting a session, 2–7

customizing, 8–1 to 8–10

startup

customizing, 8–1

specifying attributes, 4–8

startup environment

customizing, 8–1

Style Manager, 1–3, 3–2

changing colors, 4–6

changing fonts, 4–6

changing screen appearance, 4–6

customizing environment, 4–6 to 4–8

setting up backdrops, 4–6

specifying startup and logout behavior, 4–8

submenus, 2–6

subpanels

adding an application, 7–3

adding to Front Panel, 7–4

using Help menu, 3–5

using menus, 3–3 to 3–5

using Personal Application menu, 3–4

using Personal Printer menu, 3–4 to 3–5

SysMan applications, 5–17 to 5–19
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T
terminal emulator

opening from File Manager, 4–3

starting applications, 5–1

text

copying and pasting, 2–4

text editor, 3–2

text files

comparing, 5–5 to 5–7

trash can, 3–2

V
viewing documents, 5–7 to 5–8

W
warning bell

setting, 4–7

window frame, 2–3

windows

copying and pasting text, 2–4

making active, 2–4

moving, 2–4

opening dialog boxes, 2–6

resizing, 2–3

setting characteristics, 4–8

using, 2–2 to 2–7

using controls, 2–3

using dialog boxes, 2–6 to 2–7

using list boxes, 2–7

using menus, 2–3, 2–5 to 2–6

using minimize and maximize buttons, 2–3

using Option menus, 2–5

using pop-up menus, 2–5

using pulldown menus, 2–5

using push buttons, 2–7

windows (cont.)

using Radio and Check buttons, 2–6

using scroll bars, 2–3

using sliders and scales, 2–7

using submenus, 2–6

using title bar, 2–3

work area

using windows, 2–2 to 2–7

Workspace button pop-up menu, 3–6

Workspace menu

lists of options, 3–6

workspace switch, 3–6, 7–3

adding workspaces, 3–6

changing workspaces, 3–6, 7–3

renaming workspaces, 3–6

workspace switches, 3–2

workspaces, 3–2

adding, 3–6

changing colors of, 4–6

dropping directories and files, 4–3

moving between work areas, 3–6, 7–3

renaming, 3–6

specifying a background pattern, 4–7

X
X Window System, 6–2

Xaccess file, 8–10

.Xdefaults file, 8–9

xhost program

using to enable access to display, 5–2

Xservers file, 8–10

Xsession, 6–2

Xsession file, 8–10

.xsession file, 8–9

customizing keyboard with, 8–6
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How to Order Additional Documentation3333333333333333333333
Technical Support
If you need help deciding which documentation best meets your needs, call 800-DIGITAL
(800-344-4825) before placing your electronic, telephone, or direct mail order.

Electronic Orders
To place an order at the Electronic Store, dial 800-234-1998 using a 1200- or 2400-bps
modem from anywhere in the USA, Canada, or Puerto Rico. If you need assistance using the
Electronic Store, call 800-DIGITAL (800-344-4825).

Telephone and Direct Mail Orders

Your Location Call Contact

800-DIGITALContinental USA,
Alaska, or Hawaii

Digital Equipment Corporation
P.O. Box CS2008
Nashua, New Hampshire 03061

Puerto Rico 809-754-7575 Local Digital subsidiary

Canada 800-267-6215 Digital Equipment of Canada
Attn: DECdirect Operations KAO2/2
P.O. Box 13000
100 Herzberg Road
Kanata, Ontario, Canada K2K 2A6

International ————— Local Digital subsidiary or
approved distributor

Internala ————— SSB Order Processing – NQO/V19
or
U. S. Software Supply Business
Digital Equipment Corporation
10 Cotton Road
Nashua, NH 03063-12603333333333333333333333

a For internal orders, you must submit an Internal Software Order Form (EN-01740-07).





Reader’s Comments Digital UNIX
CDE Companion

AA-QTLPA-TE3333333333333333333333
Digital welcomes your comments and suggestions on this manual. Your input will help us to
write documentation that meets your needs. Please send your suggestions using one of the
following methods:

• This postage-paid form

• Internet electronic mail: readers_comment@zk3.dec.com

• Fax: (603) 881-0120, Attn: UEG Publications, ZKO3-3/Y32

If you are not using this form, please be sure you include the name of the document, the page
number, and the product name and version.

Please rate this manual: Excellent Good Fair Poor
Accuracy (software works as manual says) 5 5 5 5
Completeness (enough information) 5 5 5 5
Clarity (easy to understand) 5 5 5 5
Organization (structure of subject matter) 5 5 5 5
Figures (useful) 5 5 5 5
Examples (useful) 5 5 5 5
Index (ability to find topic) 5 5 5 5
Usability (ability to access information quickly) 5 5 5 5
Please list errors you have found in this manual:
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33333333 33333333333333333333333333333333333333333333333333333333333333333333
33333333 33333333333333333333333333333333333333333333333333333333333333333333
33333333 33333333333333333333333333333333333333333333333333333333333333333333
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Additional comments or suggestions to improve this manual:
33333333333333333333333333333333333333333333333333333333333333333333333333333
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What version of the software described by this manual are you using? 3333333333333333
Name/Title 33333333333333333333333333333333333333333 Dept. 33333333333333333333
Company 3333333333333333333333333333333333333333333333333333 Date 33333333333
Mailing Address 333333333333333333333333333333333333333333333333333333333333333
333333333333333333333333 Email 3333333333333333333333 Phone 33333333333333333
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